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 About DMTI Spatial™ 
 
DMTI Spatial Inc. is Canada’s leading spatial solutions provider. We enable users to understand their 
customers, optimize resources, realize opportunities, maximize profitability and make more informed 
decisions through accurate products and innovative thinking. 
 
DMTI Spatial publishes precision built street map, rail and routing data (CanMap®), a detailed water layer, 
and innovative geocoding and address management software (GeoPinpoint™). In addition, DMTI Spatial 
publishes a full range of positionally accurate geospatial data products including: enhanced points of 
interest (EPOI), census data and boundaries, postal geography, topographic maps, and US mapping 
data. As part of a complete business geographic solution, DMTI Spatial offers a wide range of GIS 
services, consulting, and software training. 
  
Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for 
precision built spatial data and geocoding software products. 
 
At DMTI Spatial, we believe that our true strength comes from working closely with our customers and 
providing innovative solutions to meet their strategic business objectives. As Canada’s premier spatial 
solutions provider we pride ourselves with having worked with North America’s leading organizations to 
support their mission critical applications.  
 
DMTI Spatial works with large and small organizations representative of a wide variety of industries:  
 

• Agriculture • Forestry • Mining 
• Banking/Finance • Government • Real Estate 
• Consulting • Health • Retail 
• Education • High Technology • Telecommunications 
• Emergency Services • Insurance • Transportation 
• Engineering • Manufacturing • Utilities
• Environmental • Media 

 
We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI 
Worldwide New Business Partner of the Year Award and the 2005 ESRI Foundation Partner of the Year 
Award. We are a strategic business partner of MapInfo and winner of the Markham Board of Trade 2000 
Award for Entrepreneurship and Innovation.  Recipient of The Association of Canadian Map Libraries and 
Archives (ACMLA) 2002 Certificate of Appreciation. 
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Really Smart Spatial Solutions™ 
 
Through the application of its products and services, DMTI Spatial has been involved with projects such 
as: location-based services, logistics planning, emergency dispatch, facilities management, data 
management, customer care, address management, land base development in support of network 
planning, and marketing/demographic analysis applications. 
 
DMTI Spatial can provide all of the components necessary for the acquisition, implementation, operation 
and maintenance of a successful GIS system within companies of all sizes. Through its product and 
service offering, DMTI Spatial can provide users with 5 key components: 
 
1. Accurate, detailed and compatible data 
2. Comprehensive maintenance program 
3. GIS software  

4. Consulting and services 
5. Software training 

 
DMTI Spatial™ Product & Service Portfolio
 
DMTI Spatial’s product & service offering 
includes: 

 
CanMap® - Digital Map Data for Canada 
• CanMap® Streetfiles  
• CanMap® RouteLogistics 
• CanMap® Rail 
• CanMap® Major Roads and Highways 
• CanMap® Parks 
• CanMap® Water 
 
Satellite Imagery 
• Satellite StreetView™ 
 
Municipal Amalgamations 
• Municipality Amalgamation File (MAF) 
 
Business & Recreational Points of Interest 
• Enhanced Points Of Interest (EPOI)  
 
GeoPinpoint™ Suite  
• Canada’s Geocoding Solution 
• Modular Architecture  
• Windows Standalone Desktop Version 
• UNIX, Java Wrapper, ActiveX (DLL Version)  
 
Topographic Data and Base Maps 
• Canadian Atlas Map Bundle (CAMB) 
• Populated Placenames  
• National Topographic Data Base (NTDB) 
• 30 & 90m Digital Elevation Models (DEM) 
• Clutter Data  
 
Postal Geography & Data  
• Six-Digit Postal Code File  
• Enhanced Postal Code File 
• Forward Sortation Area (FSA) Boundary File 
 

 
 
 
 
1996 Census Boundaries & Demographic Data 
• Enumeration Area (EA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

       Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
2001 Census Boundaries 
• Dissemination Area (DA) 
• Census Subdivision (CSD) 
• Census Division (CD) 
• Census Metropolitan Area/Census 

            Agglomeration (CMA/CA) 
• Census Tract (CT) 
• Federal Electoral Districts (FED) 
 
GIS Software  
• Contour Modeling and Display 
• Demographic Profiling and Lifestyle Targeting 
• Geocoding and Mapping Software 
• Routing and Logistics 
 
Consulting and Services 
• Application Development 
• Database Marketing 
• Data Conversion and Creation 
• Database Scrubbing 
• Geocoding Services  
• GIS Consulting 
• Technical Support 
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Technical Support, Error Reporting & Product Enhancement Services 
 
 
DMTI Spatial is committed to building the best products possible for our customers.  By using our data 
every day in your mission critical application you are our best source for product refinement.  Please let 
us know if you have an enhancement request or found an error in any of our products so that we can 
make the correction for the next release. 
 
This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.  
Please be as specific as possible so that we can improve our products quickly and accurately.  To submit 
an error or request technical assistance please visit: http://www.dmtispatial.com/support/ 
 
If you have an idea for a new product, or an enhancement request for an existing product, please visit our 
product manger’s desk on the web at: http://www.dmtispatial.com/pm/

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
Not to be disclosed 

 
or e-mail: pm@dmtispatial.com 
 
 
Contact Information 
 
DMTI Spatial Inc. 
625 Cochrane Drive, 3rd Floor 
Markham, Ontario 
L3R 9R9 Canada 
 
Telephone: 905-948-2000 
Toll Free: 1-877-477-DMTI (3684) 
Fax: 905-948-9404 
 
Web Site: www.dmtispatial.com 
Error Reporting Service: fixme@dmtispatial.com  
Product Enhancement Requests: pm@dmtispatial.com 
Technical Support: support@dmtispatial.com 
 
 
 
 
 
 
Trademarks and Notices 
 
© 2005 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really 
Smart Spatial Solutions, Because Where Is What Matters and GeoPinpoint are trademarks of DMTI 
Spatial Inc.  All rights reserved.  Other products and company names mentioned herein may be 
trademarks of their respective companies.  Mention of third-party products is for informational purposes 
only and constitutes neither a recommendation nor an endorsement. 
 
DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under 
Licensing Agreement 6228.  No confidential information about an individual, family, household, 
organization or business has been obtained from Statistics Canada. 
 
© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of 
Industry, Statistics Canada 2003. 
 
Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with 
permission of Natural Resources Canada and The Queen in Right of Manitoba. 

http://www.dmtispatial.com/support/
http://www.dmtispatial.com/pm/
mailto:pm@dmtispatial.com
http://www.dmtispatial.com/
mailto:fixme@dmtispatial.com
mailto:pm@dmtispatial.com
mailto:support@dmtispatial.com
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About GeoPinpoint™ Suite 
 
Overview 
 
The GeoPinpoint Suite software attaches geographic coordinates to records in a client database by 
means of matching certain database fields against a DMTI proprietary geo-reference database. The geo-
reference database is comprised of digital street geometry, street address ranges, postal coordinates, 
point of interest and other reference databases to ensure that data is “geocoded” as accurately as 
possible.  
 
When data is “geocoded”, co-ordinates can be transferred into a Geographic Information Systems (GIS) 
such as MapInfo, ArcInfo, ArcView and other software systems that support the importation of geographic 
co-ordinate locations.  
 
GeoPinpoint™ Suite positions your data using a powerful and innovative geo-location process called 
geocoding.  GeoPinpoint Suite attaches X and Y coordinates to your facility, customer or prospect 
address data for map visualization, analysis or location based applications. The GeoPinpoint Suite takes 
advantage of a new modular design that allows the software to encompass future module enhancements 
without jeopardizing its performance or usability. Based on the nationwide precision and the robust street 
address content of CanMap® Streetfiles, GeoPinpoint Suite has been engineered to geocode your data 
with a high degree of accuracy. 
 
 
Features 
 
GeoPinpoint Suite has a high degree of flexibility allowing users to customize their geocoding process by 
defining their “geocoding path”. This flexibility provides a seamless and hierarchical interoperability 
between GeoPinpoint Suite’s highly developed licensed modules: 
 

 Parser: Evaluates address information, parses and standardizes data thereby improving 
address-matching rates. The address-parsing module specifically accommodates Canadian 
addressing methods and can interpret French addressing standards.  

 Address Geocoder: Evaluates address information and returns an accurate geographic location 
in the form of longitude and latitude from the geo-reference database. Options are available 
allowing users to relax matching criteria by street prefix, street type, and street direction.  

 POI Geocoder: Evaluates a Point of Interest name and returns an accurate geographic location 
in the form of longitude and latitude from the geo-reference database. 

 Postal Code Geocoder: Evaluates address information and returns Postal Code locations in the 
form of longitude and latitude from the geo-reference database. 

 Segment Geocoder: Evaluates address information and returns the midpoint of the 
corresponding street segment from the geo-reference database. 

 
To further enhance geocoding, GeoPinpoint Suite is currently supplemented with the following modules 
(which are available with the appropriate license keys and corresponding geo-reference databases):  
 

 Soundex: An algorithm that uses fuzzy logic to help geocode street names, municipalities or 
points of interest, which may suffer from spelling variations. 
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This manual has been written to provide clients with the information they need to effectively use 
GeoPinpoint Suite. It is noted, however, every client has unique circumstances that may pose challenges 
to geocoding in addition to those covered in the GeoPinpoint Suite manual.  
 
 
Please contact DMTI Spatial for more information or questions regarding your specific requirements.  
 
DMTI Spatial Inc. 
625 Cochrane Drive, 3rd Floor 
Markham, Ontario 
L3R 9R9   Canada 
 
Telephone: 905-948-2000 
Toll Free:  1-877-477-DMTI (3684) 
Fax:  905-948-9404 
 
URL:  www.dmtispatial.com 
Email:  info@dmtispatial.com 
 

http://www.dmtispatial.com/
mailto:info@dmtispatial.com
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What’s New in GeoPinpoint Suite 
 
Software Changes 
 
• Page 47: New Muni and FSA matching functions have been added to the Address, POI and Segment  
                      Address Geocoders 
 
• Page 70: Zero Address segment geocoder has been added.  Function allows users to geocode to  
                     streets which are completely non-addressed (i.e.: range for all segments is 0 to 0). 
                     Zero address function now outputs the total segment length (TotalDistZeroStSegs(m)). 
 
• Page 73: Populated Place Name and Muni centroid geocoders have been updated to also use FSA  
                     information to help make better decisions between municipalities or PPNs with the same  
                     name occurring in the same province. 
 
• Page 97: Opposite side of street function has been enhanced. Text box to capture tolerance value 

has been added. Both ‘closest address tolerance’ and ‘opposite side of street’ functions can 
now return the actual address number (ActAddNum) that they were geocoded to. 
 

• Page 98:   Added municipality soundexing function, as well as inputting custom soundex tolerance. 
 
• Page 103: Rural Pcode to PPN function has been added.  Function allows users to alter the  
                       geocoding hierarchy of GPP Suite.  Change forces software to recognize a rural postal  
                       code and then attempt to geocode the record to PPN or Municipal centroid before rural  
                       FSA centroid.  This is useful where a muni centroid is more precise than a rural FSA  
                       centroid. 
 
• Page 108: Inset tolerance function has been added.  Function allows users to specify an inset  
                        tolerance value so that coordinates falling on or close to intersections are placed more  
                        appropriately. 
 
Documentation Changes 
 
• Page 70: Zero address function now outputs the total segment length (TotalDistZeroStSegs(m)) 
 
• Page 96/97: Both ‘closest address tolerance’ and ‘opposite side of street’ functions can now 

 return the actual address number (ActAddNum) that they were geocoded to. 
 
• Page 98: Changed title from ‘Beta Functions’ to ‘v6.3 and Greater Functions’ 
                      Added municipality soundexing and input of custom soundex tolerance. 
 
• Page 116: New result code was added for zero addressed records. Refer to 3rd digit (STREET) 

                                       Result type for Postal Codes changed; 
                                                              Prev. SNF, DA (urban), DA (rural), PPN 
                                      Now. LDU centroid, FSA centroid, PPN centroid 
 
• Page 117: New result codes were added to the 8th digit (REFINED) to highlight those records that 
                        either geocoded By Muni and FSA or where the new Rural Postal Code to PPN function  
                        was used  
 
• Page 123: New precision codes were added for those records which geocoded By Muni and FSA or 
                        to zero address. Precision type changed for Postal Codes; 
                                     Prev. SNF, DA (urban), DA (rural), PPN 
                                     Now. LDU centroid, FSA centroid, PPN centroid 
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          Installing GeoPinpointTM Suite 
 
Minimum System Requirements 
 
GeoPinpoint Suite Software and DMTI Geo-reference database 
  
Processor: Pentium 100 or higher 
OS: MS Windows (for specific versions/builds, please contact DMTI Spatial) 
RAM: 512 MB 
Disk Space: 750 MB  
 
GeoPinpoint Suite Software and DMTI Geo-reference database with Scrubber/Soundex tables 
  
Processor: Pentium 100 or higher 
OS: MS Windows (for specific versions/builds, please contact DMTI Spatial) 
RAM: 512 MB 
Disk Space: 850 MB  
 
 
Optimal Requirements: 
 
• GPP uses a proprietary Read-Only Database called the geo-reference (Georef) database 
• Higher Disk Read Speed will increase access times to this database, assuming no system 

bottlenecks from other software running on the system. 
• Increasing RAM will help with system paging (i.e. from memory rather than from disk). 
 
 
Minimum Software Requirements 
 
If you are geocoding any of the following types of databases, the associated software must be installed.  
The software will install the driver necessary to connect to a particular type of data file. 
 
Database Software 
Microsoft Access 97 Microsoft Office 97 (Access) 
Microsoft Access 2000 Microsoft Office 2000 (Access) 
dBase (dbf) files Microsoft Office 97 or Microsoft Office 2000 
FoxPro files Microsoft Visual Studio 6.0 (e.g.: Microsoft Visual FoxPro 6.0) 
Oracle 8i database Oracle 8i database 
Oracle 9i database Oracle 9i database 
 
Refer to section Data Source – MDB and ODBC files for more information. 
 
 
 
Can I install GeoPinpoint Suite v5.4 and v6.3 (or greater) on the same machine?  
 
The two versions of GeoPinpoint Suite cannot be installed and run on the same machine because they 
are using the same file (.dll) names.
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Quick Installation Instructions 
 
Current Users of GeoPinpoint Suite 

 If upgrading from a previous version of GeoPinpoint Suite, please refer to “Upgrading 
GeoPinpoint Suite” 

 
Copying the Data from the CD 

 Insert the GeoPinpoint Suite CD. A setup dialog automatically opens prompting the user to read 
and accept the license agreement. Once the user has read the licensing agreement, the user 
should click “I Agree” to proceed with the installation. This setup copies data and/or software to 
the local hard disk does not install the GeoPinpoint Suite software. 

 Installing the Data: The next dialog prompts the user to indicate where the data should be stored. 
The default directory can be accepted, or alternatively the user can navigate to the desired 
storage folder using the navigation tools on the right side of the dialog. The user should click the 
“Install” button and the data will be stored in a folder named “GeoPinpoint” or a user-defined 
folder within the specified path. 

 
Installing GeoPinpoint Suite  

 From the Start menu, select “Run” or use Windows Explorer to navigate to the setup.exe file 
located in the directory path where the GeoPinpoint Suite data has been stored. For example, 
“Start>Run>"C:\Data\GeoPinpoint\Windows\Setup\Setup.exe" 

 A dialog will ask the user whether to proceed with the installation. Click “Ok” to proceed. 
 The user will be prompted for a directory where the software should be installed. Once the 

desired directory has been selected, the user must Click the “Installation button”. 
 The user will be prompted for the Program Group to which GeoPinpoint Suite should be added. 

Click “Yes” to proceed when the desired group has been selected.  This name can also be user-
defined. 

 Upon completion of the GeoPinpoint Suite installation, a message will appear indicating that the 
software has been successfully installed. 
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Detailed Installation Instructions  
 
Copying the Data from the CD 
 

1. Insert the GeoPinpoint Suite CD. 
2. A setup dialog automatically opens prompting the user to read and accept the license agreement.  
3. Once the user has read the licensing agreement, the user should click the “I Agree” button to 

proceed with the installation. This setup copies data and/or software to the local hard disk and 
does not install the GeoPinpoint Suite software. 

 

 
 

4. The next dialog prompts the user to indicate where the data should be stored. The default 
directory can be accepted, or alternatively the user can navigate to the desired storage folder 
using the navigation tools on the right side of the dialog.  

 

 
 

5. Click the “Install” button. 
6. Select “Yes” to start the installation. When the data has been installed a dialogue will indicate that 

the transfer was successful. Once complete, the GeoPinpoint folder will contain three folders 
including Docs, Georef and Windows. 
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Installing GeoPinpoint Suite  
 

1. From the Start menu, select “Run” or use Windows Explorer to navigate to the setup.exe file 
located in the directory path where the GeoPinpoint Suite data has been stored. For example, 
“Start>Run>"C:\Data\GeoPinpoint\Windows\Setup\Setup.exe" 

2. A dialog will ask the user whether to proceed with the installation. Click “Ok” to proceed with the 
installation or Click “Exit Setup” to exit the installation process. Refer to “Canceling Installation” 
for more information.  

 

 
. 

3. The user will be prompted for a directory where the software should be installed. Once the 
desired directory has been selected, the user must Click the “Installation button” or click “Exit 
Setup” to exit installation program. Refer to “Canceling Installation” for more information.  

 

 
 

4. Click “Change Directory” button to change default location to user-selected location.  
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5. Enter the path where the installation program will install the software or alternatively use the 
Drives/Directories box to select another location. 

6. Click “OK” to return to the Install software dialog or Click “Cancel” to accept the default Path for 
software installation.  

7. After Clicking the “Installation button” on the GeoPinpoint Suite setup dialog, the following dialog 
will appear: 

 

 
 

 
8. The user will be prompted for the Program Group to which GeoPinpoint Suite should be added.  
9. Click “Yes” to proceed when the desired group has been selected. Choose either the pre-defined 

GeoPinpoint Suite or enter a user-defined Group Name and then click the Continue button. A 
status bar will indicate installation progress.  

 

 
 

10. If the Cancel button is Clicked at this point in time, Click “No” to return to the installation status 
bar. Clicking “Yes” will result in exiting the installation. Refer to “Canceling Installation” for more 
information.  
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11. Upon completion of the GeoPinpoint Suite installation, a message will appear indicating that the 
software has been successfully installed. 

 

 
 

Attention! It is always a good practice to restart the computer prior to any software 
installation, and following any software installation. Any applications that are running 
should be closed before proceeding with the installation to reduce complications with 
updating shared files. 
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Error Messages  
 
Error Message – ST6UNST.exe  
 
Cause: The following error message box may appear depending on where the “Exit Setup” button within 

the GeoPinpoint Suite installation process. 
 
Solution: Press OK button.  Navigate to installation directory to read error log file. 
 

 
 
 
Error Message – Version Conflict  
 
Cause: Since GeoPinpoint Suite installs it’s own set of libraries (dlls) a Version Conflict dialog may 

appear.  Refer to Appendix 1 for more example version conflict snapshots. 
 
Solution: GeoPinpoint Suite may use older versions of library files. Click ‘Yes” to retain the current      

libraries, “No” or “No to All “ to overwrite libraries. 
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Error Message – Run-time error ‘429’  
 
Cause: The following message may occur if the data and software are copied over using the TMSetup 

and the user then clicks on the GeoPinpoint.exe rather than the setup application for GeoPinpoint 
Suite. This error is caused because the dll’s for GeoPinpoint Suite have not been registered. 

 
Solution: Install the software using the setup application. 
 

 
 
 
 

Canceling the GeoPinpoint Suite Installation Program 
 

1. If the Exit Setup button is Clicked, the following message box appears: 
 

 
 

2. Click “No” to return to the previous screen or Click “Yes” to interrupt the installation 
 

 
 

3. Click “OK” 
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4. Click “No” to return to the previous screen or Click “Yes” to uninstall 
 

 
 

5. Click “OK” to initialize the uninstall program. After all files have been removed, the following 
dialog will appear: 
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Upgrading GeoPinpoint Suite 
 

Hint! To avoid re-entering GeoPinpoint Suite license keys - copy the “gpps.lic” file from 
the old Georef/Com directory to a safe location. Once the new GeoPinpoint Suite is 
installed, copy the “gpps.lic” to the new Georef/Com directory. This tip is only useful when 
using the file on the same computer which generated this file. 

 
 
Older versions of GeoPinpoint/GeoPinpoint Suite Windows Desktop or GeoPinpoint Suite ActiveX must 
be fully uninstalled prior to installing the new version of GeoPinpoint Suite. Ensure that the following has 
been completed before installing GeoPinpoint:  
 

1. The GeoPinpoint/GeoPinpoint Suite software is uninstalled using Microsoft's Add/Remove 
Programs utility 

2. The GeoPinpoint/GeoPinpoint Suite link to the product (i.e.: Start > Programs> GeoPinpoint OR 
Start > Programs> GeoPinpoint Suite) has been removed 

3. The GeoPinpoint/GeoPinpoint Suite folder has been deleted (i.e.: C:\Program Files\GeoPinpoint) 
 
If one or more of the following have not been done, perform the following steps to ensure that a clean 
uninstall was performed. 
 

1. To uninstall the software using Microsoft's Add/Remove Programs utility: 
 

 Start > Settings > Control Panel > Add/Remove Programs 
 Under the currently installed programs: Locate and Select GeoPinpoint/GeoPinpoint Suite 
 Click “Change/Remove” button 
 Click “Yes” to uninstall the GeoPinpoint/GeoPinpoint Suite 

 
2. To remove the link to the product (i.e.: Start > Programs> GeoPinpoint OR Start > Programs> 

GeoPinpoint Suite) 
 

 Start > Programs > GeoPinpoint/GeoPinpoint Suite.  
 Hover over the link and right-click to select “Delete” 

 
3. To uninstall the folder where the product was installed (i.e.: C:\Program Files\GeoPinpoint) If the 

GeoPinpoint/GeoPinpoint Suite folder cannot be located use the Start > Search > For File or 
Folders function. 

 
 Open “Windows Explorer” 
 Navigate to the location of the GeoPinpoint/GeoPinpoint Suite folder 
 Delete the GeoPinpoint folder 
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GeoPinpoint Suite 4.0 Users 
 
If GeoPinpoint Suite 4.0 is currently installed and the user is upgrading to 5.x, the following message will 
appear when deleting the GeoPinpoint folder from c:\Program: 
 

 
 
Click “Yes”. Performing this action will not result in affecting other programs. 
 
If the user has installed GeoPinpoint Suite v4.0 to a directory other than C:\Program Files\GeoPinpoint 
such as C:\DMTI the following message will appear:  
 

 
 
Select the Remove button to perform a clean uninstall.  
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GeoPinpoint Suite License Keys  
 
Installing the GeoPinpoint Suite License Keys 
 
After installing the GeoPinpoint Suite, the user will be required to enter the purchase and/or evaluation 
license keys obtained from DMTI Spatial in order to begin geocoding.  
 

Attention! The purchase and/or evaluation key’s accompany the GeoPinpoint Suite CD.  
 
Please refer to the following example of license keys: 
 
Client Name: Dmti 
 
Purchase key is generated on 5/15/2004 2:26:13 PM 
Module    : AddressGeoCoder 
Key                 : XXXX XXXX XXXX XXXX   
 
Purchase key is generated on 5/15/2004 2:26:13 PM 
Module    : POIGeoCoder 
Key                 : XXXX XXXX XXXX XXXX   
 
Purchase key is generated on 5/15/2004 2:26:13 PM 
Module    : PostalCodeGeoCoder 
Key                 : XXXX XXXX XXXX XXXX   
 
Purchase key is generated on 5/15/2004 2:26:13 PM 
Module    : SegmentGeoCoder 
Key                 : XXXX XXXX XXXX XXXX   
 
Purchase key is generated on 5/15/2004 2:26:13 PM 
Module    : Soundex 
Key                 : XXXX XXXX XXXX XXXX   
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Upon entering the GeoPinpoint Suite application for the first time, the user will see the following message 
box appear (if message does not appear – use File > Generate License File): 
 

 
 
 

Attention! If you have already evaluated the GeoPinpoint Suite product on your 
computer and wish to evaluate the soundex modules – you will have to install the 
software on a different computer than the one you previously installed on. 

 
 
The following license key entry steps below are the same for purchase and/or evaluation license keys. 
 

1. Click OK and the license module dialogue will appear. 
 

 Note: When entering the license keys for the first 
time, enter the Client Name value to reflect the 
client name that is provided by DMTI Spatial.   
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2. Click “Browse…” on the License dialog and select the location 
where Georef has been saved. Select the location where the 
Georef database is located. Do not select any of the 
corresponding folder under the Georef folder (e.g.: Ab, Com, 
etc) 

 
 
 
 
 
 

3. Click “Select”  

Hint!  Selecting the Save as Default option button will 
allow GeoPinpoint Suite to display the Georef location 
information on the Data Sources tab. 
 

 
 
 
 
To enter each of the license keys into the License dialog begin by: 
 

4. Enter the client name provided by DMTI Spatial 
5. Check off the checkbox beside the appropriate module(s) 
6. Enter the license key into the 4 textboxes beside this module 
7. After the user has finished entering the license keys, press the Generate License File button to 

create a file called “gpps.lic”. This file is stored in the Com directory in the Georef (e.g.: 
D:\Georef\Com) 

8. If the license file creation process was successful the following message boxes occur: 
 

 
 

 
 
 
If the license file creation process was unsuccessful the following message boxes will occur 
 

 
 

Ensure that the  
 Correct client name has been entered 
 Correct license key(s) have been entered incorrectly for each module 
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9. After creating a valid license key (gpps.lic) file, press the Exit button. 

 
 
After creating a license key, the user can see whether they 
have entered a purchase or evaluation license key into 
GeoPinpoint Suite: 
 
File > Generate License File will yield a similar result: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Evaluation GeoPinpoint Suite License Keys 
 
When using the evaluation geocoder modules, the following message will appear before opening the 
Define Geocoding Path dialog. This information reminds the user how much time remains in the 
evaluation period for each evaluation geocoder module.  The message will only reflect those modules that 
have been installed: 
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Attention: When a evaluation key(s) expires, the Define Geocoding Path will no longer 
display that respective geocoder module. 

 
 
 
Upgrading Evaluation GeoPinpoint Suite License Keys 
 
These steps should be following if the user wishes to upgrade one or more of the evaluation keys to a 
purchase license key: 
 

1. File > Generate License File to bring up the License 
dialog 

2. Delete the evaluation key that exists for that module (e.g.: 
remove text from textbox) 

3. Enter new purchase license key information into this 
module (e.g.: Address Geocoder) 

4. Confirm that the license information has been entered 
correctly 

5. Press the Generate License File button 
6. Should see a message box stating: “License File is 

created successfully!” and “Valid license file!” 
7. Exit the License dialog 
8. File > Generate License File to make sure the type of 

license has changed 
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Error Messages 
 
 
Error message: “Load License File Error” 
 
Causes:  
 
When an open error or read error occurs with the license file this message box will be displayed. 
 

 License file (gpps.lic) was edited. 
 Select one and/or more geocoder checkboxes in the license entry dialog and press the License 

Verifier button without having entered any license codes 
 Client name text box in license entry dialog was left empty during license file creation. 

 
Solution:  
 

 Create a copy of the license file and then rename the license file. 
 Enter the purchase and/or evaluation keys into the license dialog for GPP Suite and create a new 

license file (gpps.lic). 
 Check to ensure that the Client name textbox has been populated with the value that is contained 

within the license document that accompanied the software. 
 
 
 
Error message: “Verify Check Sum Error” 
 
Cause:  License file has been edited.   
 
Solution:  Enter the license keys once again. 
 
 
 
Error message: “Verify Trial Period error” 
 
Cause:  Trial period for evaluation license has expired.   
 
Solution:  Install purchase license.  
 
 
 
Error message: “Verify Machine ID error” 
 
Cause:  License file from Georef\Com directory has been copied from one computer to another.    
 
Solution:  Delete the gpps.lic file and re-enter the purchase license keys. 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 28 

     Canadian Geography and Data - Summary 
 
GeoPinpoint Suite software utilizes DMTI Spatial Canadian data to provide the most precise geocoded 
results to its users.  
 
The following Canadian data is found in the geo-reference database by each province: 

 
 CanMap Street Files 
 Census Subdivision (CSD) centroids 
 Points of Interest (POI) 
 Populated Place Names (PPN) 
 Platinum Postal Suite (PPS) 
 Forward Sortation Area (FSA) centroids 

 
Refer to section “Geo-reference Database” to learn more information about the role this feature plays in 
the GeoPinpoint Suite software. 
 
 
Basic Canadian Geography 
 
Canada contains 10 province and 3 territories*.  
 

Province Name  
(English) 

Province Name  
(French) 

Abbrev

Alberta Alberta AB 
British Columbia Colombie-Britannique BC 
Manitoba Manitoba MB 
Newfoundland and Labrador Terre-Neuve et Labrador NL 
New Brunswick Nouveau-Brunswick NB 
Northwest Territories* Territoires du Nord-Ouest NT 
Nova Scotia Nouvelle-Écosse NS 
Nunavut* Nunavut NU 
Ontario Ontario ON 
Prince Edward Island Île-du-Prince-Édouard PE 
Quebec Québec QC 
Saskatchewan Saskatchewan SK 
Yukon* Yukon YT 
 
 
CanMap Street Files 
 
The geo-reference database used by GeoPinpoint Suite to geocode all Canadian data is based on the 
CanMap® street file.  The CanMap® street file includes street centerlines and address ranges, and it is 
updated by DMTI Spatial on an ongoing basis.  CanMap® contains street naming for communities down 
to, and in some cases, under 1,000 population and street addressing for communities down to, and in 
some cases, under 2,000 population. This data is North America’s #1 choice for Canadian data provides 
an accurate map fabric for wireless and location based service applications (LBS), market analysis, target 
marketing, site location analysis, customer service and asset management. 
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This data consists of the following: 
 

 Over 1.5 million km across Canada 
 Street centerline road network, names and address ranges 
 Roads look up table including alias name, highway numbers and names, road numbers and more 

 
This information is used to geocode records to address number, street alias and other GeoPinpoint Suite 
functionality. 
 
 
Census Subdivision (CSD) centroids 

 
CSDs are municipalities or equivalent areas (e.g.: Indian reserves, Indian settlements and unorganized 
territories) as determined by provincial legislation. The municipal boundaries are derived from the 1996 
Census Subdivision (CSD) boundary files. 
 
In Newfoundland, Nova Scotia and British Columbia, the term CSD also applies to geographic area that 
have been created by Statistics Canada to assist with reporting of statistical data.1 

 
 
 
 
 

Note: There are two municipality (CSD) values in Canada which occur between 2 provinces.  
          Flin Flon (Manitoba and Saskatchewan) and Lloydminster (Saskatchewan and Alberta).   
          Each CSD part occurring in the above province is represented as a separate CSD value.  

 
 
Points of Interest (POI) 
 
The Enhanced Points of Interest (EPOI) file is a national database of Canadian business and recreational 
points of interest. Engineered using CanMap® Streetfiles, each EPOI has been accurately geocoded and 
precisely placed; two criteria that are fundamental to any successful location sensitive service. 
 
This location enriched point of interest database allows users to see and analyze selected point of 
interest data in a given geographic area, enabling applications such as wireless location-based services 
(LBS), Web, Telematics, planning, real estate multiple listing services (MLS), retail site analysis, 
competitive and market research, intelligent routing, sales territory analysis, business and tourism. 
 
DMTI Spatial currently stores approx ~40,000 POI points in the geo-reference database. The following 
types of POI data are stored: 
 

 Aerodromes 
 Border Crossings and Custom Offices 
 Car Rental Agencies 
 Hotel Accommodations 
 Golf Courses 
 Police Stations 
 Toll Booths 
 Education & Health Care 
 Financial Institutions 
 Tourist Information 

 
Refer to Appendix 5: Points of Interest Layers for more information. 
 
 
1 Source: Statistics Canada - Catalogue No. 92-351-UIE, 1996 Census Dictionary, Final Edition    
  Reference. August 1999.
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Populated Place Names (PPN) 
 
The Populated Placenames database includes Cities, Towns, Villages, Communities, Boundaries and 
other records describing ‘Populated’ places across Canada. 
 
Based on the Canadian Geographic Names Database (CGNDB) as well as the toponymic data from the 
National Topographic Database (NTDB), this data product has been enhanced by more accurately 
aligning the features in relationship to CanMap ® Streetfiles. Each point is flagged with a “Precison” code, 
which categorizes the feature based on its positional accuracy.  This makes PPN information a cost 
effective data product for macro level geocoding and mapping applications.  This accurate placement of 
data points is due to CanMap Streetfiles positional accuracy and additional research and verification 
 
 
Platinum Postal Suite (PPS) 
 
The CanMap Six Digit Postal Code product is a precision-based point file of postal codes across 
Canada. This Six Digit Postal Code product contains over 800,000 postal code points positioned to the 
most representative address. The majority of the points are located to the specific address (in the case of 
large apartment buildings or office towers) or the most representative address [where the same FSALDU 
(forward sortation area local delivery unit) services multiple addresses].  This degree of positional 
accuracy is made possible because of the postal codes are geocoded using CanMap® street map data. 
 
A Postal Code, otherwise know as – 6 Digit Postal Code, or “FSA LDU”, is defined and maintained by 
Canada Post for the sorting and delivery of mail. Postal Codes are also widely used as a means of 
geocoding databases for the purposes of location analysis, demographic analysis, and other types of 
geographical enabled analyses. 
 
A postal code is comprised of an FSA LDU, or in other words - a Forward Sortation Area and a Local 
Delivery Unit. The characters are arranged in the form “ANA NAN” where “A” represents an alphabetic 
character and “N” represents a numeric character (i.e. L3R 9T8). The first character of a postal code is 
allocated in alphabetic sequence from East to West across Canada and denotes a province, territory or a 
major sector found entirely within the boundaries of a province.1 

 

 
 
 
Rural postal codes can be distinguished from urban postal codes because the second character is “0” 
(zero). One rural postal code, with multiple positions, may represent several small rural towns. 
 
 
 
 
 
 
 

1 Source: Understanding Postal Code Files – Multiple and Unique Enhanced Postal Code Files v.s. the    
  Six Digit Postal Code Files, DMTI Spatial whitepaper, 2003
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Forward Sortation Area (FSA) Boundaries 

 
The first three characters of a postal code represent the Forward Sortation Area (FSA) indicating a 
geographic area in an urban or rural area. The first character of the Forward Sortation Area identifies one 
of the 18 major geographic areas, provinces or districts. 

 
 
The second numeric character (numerals 0-9) of the Forward Sortation Area Boundary identifies either an 
urban postal code or a rural postal code. Rural postal code are represented by the numeral 0 (zero) for 
example, (A0A) and are serviced by rural route drivers and/or postal outlets. An urban postal code is 
represented by the numerals 1 to 9 for example, (E2J) and are generally serviced by letter carrier or 
community mailboxes. 
 
The third character of the Forward Sortation Area segment (E2J) in conjunction with the first two 
characters, describes an area of a city or town or other geographic area.1 

 
 
Local Delivery Unit (LDU) 

 
The last three characters represent the Local Delivery Unit (LDU) identifying a specific business or 
residential point of delivery located within a Forward Sortation Area. 
 
FSA boundaries may include multi-polygon regions, for example two or more polygons forming one 
region/entity reflecting the complexity inherent in FSA geography. Generally FSA boundaries conform to 
streets, administrative boundaries and other physical features within CanMap ® products.1 

 
 
 
 
1 Source: CanMap Postal Geography. Feb 2004. 
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     Using GeoPinpoint Suite 
 
Starting GeoPinpoint Suite  
 
GeoPinpoint Suite is launched using the Windows Start Menu.  Go to the Programs folder and Select 
GeoPinpoint Suite (Start > Programs > DMTI SPATIAL > GeoPinpoint Suite). 
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After launching GeoPinpoint Suite, the GeoPinpoint Suite dialog appears.  This dialog defines geocoding 
parameters and initiates a geocoding session. 
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GeoPinpoint Suite Menus 
 
GeoPinpoint Suite Menus conform closely to other Windows applications and include the following: 
 
 
File Menu 
 

 
 
The following commands are available:  
 

 Generate License File: Allows user to enter the purchase and/or evaluation key(s).   
 

 Define Geocoding Path: Allows user to open the GeoPinpoint tree.  The GeoPinpoint tree allows 
users to define their geocoding requirements and select a pre-defined geocoding path 

 
 Save Settings: Allows user to save their selected geocoding options.  Geocoding options are 

stored in a configuration file (*.cfg).  This option is beneficial for users who geocode multiple 
tables and wish to use the same geocoding options for each table.  In order for this utility to work 
all fields entered on the Data Sources tab must be filled in. 

 
 Load Setting From File: Allows user to load previously saved geocoding options (*.cfg) and 

current geocoding path.   
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If loading the settings for an ODBC connection, the user will encounter the following dialog before 
being allowed to make the connection to the Oracle database.  Enter the password and click the 
OK button. 

 

 
 

 Exit: Allows user to exit the GeoPinpoint Suite. 
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Tools Menu 
 

 
 
The following commands are available:  
 

 Generate Summary Report: This tool generates a summary report of result codes, precision 
codes, total number of records geocoded, and what those records were geocoded to for a 
geocoding session.  The report is saved as a text file with a “*.rept” extension.   

 
The following options are available 
 
Yes: If the user selects Yes, upon completion of a geocoding session, GeoPinpoint Suite will 
prompt the user where to save the summary report.   
 
No: If the user selects No, upon completion of a geocoding session, a summary report is not 
generated.  This option is currently the default value for this command. 
 
If No was selected and the user still wishes to create a summary report, the user can select the 
Generate Summary report command. 
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 Result Code Interpreter: This tool assists the user 

in deciphering result codes.  Upon completion of a 
geocoding session, the user can use this tool to 
determine the meaning of a geocoding result code. 
 
All results codes relating to the geocoding session 
will appear in the drop down list, or alternatively, 
the user has the option to manually type in a result 
code.   
 
If the user chooses to manually type in a result 
code, the Show Description button must be clicked 
to display the interpretation of the result code.  To 
dismiss the Result Code Interpreter, click the Exit 
button.   
 
For a more detailed explanation of result codes, 
refer to Appendix 2: Interpretation of Result Code 
(Rcode). 

 
 
Error Message: Result Code is Wrong 

 
This error message occurs if a user enters a code 
that is not recognized.  Refer to Appendix 2: 
Interpretation of Result Code (Rcode) for result 
code values.  
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Help Menu 
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The following commands are available:  
 

 Help: Provides help in order to verify GeoPinpoint Suite functions and definitions.   
 

 
 
 
Attention Windows NT Users: If the Microsoft Vector Markup Language (VML) package is not installed, 
GeoPinpoint Suite users may experience duplicate Help images.  Once this package has been installed 
the problem will be rectified. 
 
 

 About GeoPinpoint Suite: This option calls a dialog that contains trademark information on 
GeoPinpoint Suite and corporate information about DMTI Spatial. 
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GeoPinpoint Suite Dialog 
 
Upon execution, the GeoPinpoint Suite dialog guides the user through the geocoding process:  
 

 
  

 Data Sources: Allows the user to define the geocoding path, specify the appropriate geo-
reference database, target database, and target database table for geocoding.  A SQL query may 
be typed into the Table/SQL window if specific records in the table require geocoding. 

 
 Input Specifications: Allows the user to specify the fields in the table that will be used for the 

geocoding process.  Tables may be geocoded using different combinations of the address field, 
postal code field, and place name field.  This tab also allows the user to select the specific 
geocoding options that are desired. 

 
 Output Specifications: Allows the user to specify the output fields for the coordinates (longitude, 

latitude), result code, and precision code data. Records can be geocoded in batch or interactively. 
 

 Geocode: Geocoding results are updated in the “Result’s Window” as records are being 
geocoded. 

 
 Next: The user can move forward through the geocoding steps using the Next button.   

 
 Exit: This button can be used to terminate GeoPinpoint Suite at any time. 
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Defining Data Sources  
 
Using the Data Sources tab, the user can define the geocoding path and directs GeoPinpoint Suite to the 
location of the geo-reference database and which table (or records within a table) should be geocoded. 
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Geo-reference Database 
 

 
 
 
 
Geo-reference Database – Source Data 
 
The geo-reference database is a proprietary database supplied by DMTI Spatial that must be used in the 
GeoPinpoint Suite.  The geo-reference database is released quarterly, in line with the updates to the 
CanMap Streetfiles.   
 
The geo-reference database contains the following data: 
 

 CanMap Street Files  
 CSD centroids 
 Points of Interest (POI) 
 Populated Place Names (PPN) 
 Platinum Postal Suite (FSA centroids) 

 
For a more detailed explanation of this data, refer to above section “Canadian Geography and Data - 
Summary”   
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Geo-reference database – Major version changes 
 
For each major version of the GeoPinpoint Suite software (e.g.: v3.x, v4.x, v5.x, v6.x), significant geo-
reference database changes have occurred as a result of added functionality to the software or database 
structure.  Therefore, it is important to use the most current version of the geo-reference database to take 
advantage of these new additions. 
 
 
 
Geo-reference Database location 
 
Click “Browse…” on the License dialog and select the location where Georef has been saved. Select the 
location where the Georef database is located. The Georef folder is located where the software was 
installed.  Refer to above installation steps for more information.  Do not select any of the corresponding 
folders under the Georef folder (e.g.: Ab, Com, etc) as the software will then be unable to read the 
contents of the geo-reference database. 
 
 
 
 
 
 
 
 
The geo-reference database can also be stored on a network 
computer instead of where the software is installed if space is a 
concern.  To connect to a remote geo-reference database, refer  
to Appendix 8: Georef Network Connection for more information.  
 
 
 
 
 
 

Hint!  Selecting the Save as Default option button will 
allow GeoPinpoint Suite to display the Georef location 
information on the Data Sources tab. 
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Geo-reference database – Software versions 
 
The following table outlines the software versions and the correct geo-reference database versions they 
can interact with: 

 

Release Date GeoPinpoint Suite 
Version Geo-reference version 

   (version.txt) 
Nov-03 v5.0 v7.3 
Feb-04 v5.1 v8.0 
May-04 v5.2 v8.1 
Aug-04 v5.2 v8.2 
Nov-04 v5.4 v8.3 
Feb-05 v5.4 v2005.1 
May-05 v5.4 v2005.2 
Aug-05 v5.4 v2005.3 
Nov-05 BETA v2006.1 v2005.4 
Feb-06 BETA v2006.1 v2006.1 
May-06 BETA v2006.2 v2006.2 
Aug-06 BETA v2006.3 v2006.3 
Nov-06 v6.3 v2006.4 
Feb-07 v6.4 v2007.1 

                May-07 v6.4 v2007.2 
                Aug-07                   v6.4 v2007.3 

 
 
 
 
 
 
 
Version.txt file - Explanation 
 
 
Sample version.txt contents for GeoPinpoint Suite v6.4 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Geo-reference Database version: v2007.3 
 
Version of software: GeoPinpoint Suite v6.4 
Alternative software version(s): N/A 
 
Geo-reference database sources include: 

• CanMap Street Files  
• Platinum Postal Suite (PPS) 
• Points of Interest (POI) 
• Populated Place Names (PPN) 

Version of CanMap 
Streetfiles used   

This area provides information on 
which GPP Suite version(s) the geo-
reference database should be used 
with 

This area lists the data sources that 
are used in the creation of the geo-
reference database 

Note: The version.txt is stored under the Georef folder (e.g.: C:\Georef) 
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Defining The Geocoding Path 
 
Once launching GeoPinpoint Suite, the geocoding path must be defined.  Geocoding options include:  
 

 Address Geocoder 
 POI Geocoder 
 Postal Code Geocoder 
 Segment Geocoder and  
 Boundary 

 
 

 
The geocoding path and it’s modules are 
organized in a hierarchal order.   
 
The geocoding modules and their functions 
are listed in order from most precise 
(Address Geocoder) to least precise 
(Boundary Geocoder).  
 
 

 
Refer to Appendix 3: Interpretation of Precision Code for more information on precision within 
GeoPinpoint Suite. 
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Geocoding precision depends on two things: 
 
 1) The input data that is being geocoded 
 2) The level of geocoding precision the user wishes to achieve 
 
First, input data is important to consider when trying to achieve a certain level of geocoding precision 
(e.g.: To address).  For example, if a user was to select the address geocoder by municipality – the input 
record must contain the following address components (unparsed or parsed) in order to geocode: 

 
 Address Number 
 Street Name 
 Street Type 
 Street Direction 
 Municipality 
 Province 

 
 
Refer to the geocoding function sections below to obtain more information on what is expected by each 
geocoding module when they geocode input data.  
 
For those times when the address information is incorrect or missing for the address geocoder to find a 
match, the GeoPinpoint Suite software allows the users to select functions which will assist in the 
geocoding process.  For example, the record has the address number and street name but is missing the 
street type – in this situation, a relax type function may be warranted such as the ‘Relax on Street type’ 
function can be used.   
 
Refer to Input Specifications – General Geocoding options section for more details. 
 
Secondly, the user may determine that they only need to geocode their data to postal code centroid, as 
this level of precision satisfies their project data requirements.  For example, a user may have a database 
with address records but only wishes to geocode to postal code.  As long, as postal code data exists 
within the database – the software will return the user-defined precision to the user.  
 
 
 
 
 

Note: If all of the geocoding functions are initialized – GeoPinpoint Suite will follow the geocoding  
          sequence outlined in Appendix 6: Geocoding Sequence. 
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Each geocoder (address, POI, postal code, segment) module has functions that either geocode to By 
Municipality and FSA or By Municipality or By FSA.  These types of functions are common to all of the 
geocoder modules listed below.  
 
Geocoding By Municipality and FSA… 
 

 
 
Each geocoder module has a function <By Municipality and FSA> (see Address Geocoder | By 
Municipality and FSA in the example above).  These functions, depending on the geocoder module used 
will: 
 

1. Accept the input data 
2. Search the geo-reference database 
3. Geocode the record after confirmation of its existence in the input municipality and FSA 

boundary. 
 
This is an important function because it helps to properly geocode those records, which use 
municipality values, which are a MAF value (i.e.: one muni value is equivalent to many muni value).   
An example of a MAF value is Toronto, which is equivalent to 6 CSD values (Toronto, North York, 
Etobicoke, East York, York and Scarborough). 
 
 
Example Input record: 
Address 28 Byng Ave 
Municipality Toronto 
Province Ontario 
Postal Code  

 
In this example, the address 28 Byng 
Ave, Toronto, ON (i.e.: large stars) is 
found in the 1996 CSDs of Etobicoke, 
North York and Scarborough.  This 
address can only be geocoded to the 
correct location when the Address By 
Municipality and FSA or Address By FSA 
geocoder functions are used. 
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Geocoding By Municipality… 
 

 
 
 
Each geocoder module has a function <By Municipality> (see Address Geocoder | By Municipality in the 
example above).  These functions, depending on the geocoder module used will: 
 

1. Accept the input data 
2. Search the geo-reference database 
3. Geocode the record after confirmation of its existence in the input municipality boundary. 

 
 
 
 
 
Example Input record: 
Address 625 Cochrane Drive 
Municipality Markham 
Province Ontario 
Postal Code L3R9R9 
 
In this example, the address 625 Cochrane 
Dr is geocoded within the municipality 
boundary or polygon of Markham, Ontario. 
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Municipality Aliasing 
 
The geocoder modules <By Municipality> functions also use an internal process called “Municipality 
Aliasing”, which searches an alias table stored in the geo-reference database.  This table is a 
combination of CSD names, formerly used names (e.g.: Downsview, Etobicoke), and a total of names 
collected by observation through the extensive data processing undertaken by DMTI Spatial.  The 
purpose of this alias table is to allow users to enhance their geocoding match rate by providing links 
between municipality values where one value may be known as another.  This table is updated on a 
semi-annual basis. 
 
 
An example of where this functionality is used is the address: 350 Kennedy Rd, Toronto, ON.   
 
The input municipality value of Toronto can either mean one of two things: 
 

1. The user knows/believes that the address occurs within the municipality of Toronto 
2. The user has mistaken the value of Toronto to represent the true municipality value of a smaller 

division of Toronto (e.g.: Etobicoke) 
 
This table provides examples of possible municipality values which are sometimes used interchangeably 
with the value Toronto. 
 

Input Municipality 
Values 

Possible Municipality 
Alias Values 

Toronto East York 
 North York 
 Scarborough 
 Etobicoke 
 York 
 Metropolitan Toronto 

 
 
By looking at the above table, we can see that Toronto is used sometimes instead of Etobicoke when 
trying to geocode a record.  This may be because they are not from the area or only know of Toronto as a 
general municipality value. 
 
When GeoPinpoint Suite looks up this address in the geo-reference database, it will first search for the 
information that falls within the original input municipality value (“Toronto”) and any alias values that are 
related to Toronto.  In this example, if Toronto is not found to contain this address information, two 
municipality results are returned to the software: Scarborough and Dryden.  This street can also be found 
in Dryden but because it does not have a municipality alias relationship to Toronto, it will not be 
considered as a match by the software. 
 
There are times where a record may geocode incorrectly to a different municipality value other than what 
was intended by the user.  A reason for this is that the address number and street do not occur in that 
particular municipality.   
 
Therefore, the information does not exist in Toronto but was instead found to exist in other municipalities.  
When GeoPinpoint Suite Windows encounters multiple solutions (i.e.: same address occurring in related 
municipalities), it will return the first value that it finds.   Records which geocode using municipality alias 
can be identified for the user via the results codes (i.e.: 5th digit of result code = 6).  Refer to Appendix 2 – 
Interpretation of Result Code (Rcode). 
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Identifying records which geocoded using the municipality alias functionality can allow the user to: 
 

 Examine those records whose municipality values may have been entered incorrectly OR 
 Communicate a missing street segment and/or range to DMTI Spatial via their error reporting 

website (http://www.dmtispatial.com/helpdesk/index.html) 
  

 
 
 Hint! Correct municipality values can be added to the user’s input database by using Scrubber  

         functionality while using the Address geocoder.  Refer to section “Input Specifications –  
         Scrubber” for more information on the Scrubber. 
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Geocoding By FSA… 
 

 
 
Each of the geocoder modules also has a function <By FSA> (see Address Geocoder | By FSA in the 
example above).  These functions, depending on the geocoder module used will:  
 

1. Accept the input data 
2. Search the geo-reference database 
3. Geocode the record after confirmation of its existence in the input FSA boundary.  

GeoPinpoint Suite will take the FSA value (e.g.: L3R) from the postal code (e.g.: L3R9R9). 
 
 
 
Example Input record: 
Address 625 Cochrane Drive 
Municipality Markham 
Province Ontario 
Postal Code L3R9R9 
 
In this example, the address 625 Cochrane Dr is 
geocoded within the FSA boundary or polygon of 
L3R. 
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Using geocoding functions By FSA also provides another method for geocoding when the following 
scenario is encountered: 
 

 Sometimes an FSA encompasses two or more municipalities in some rural areas.  For example, 
this would allow the user to find a street, which may pass between two municipalities. 

 
 
 
 
 
 
 
Here is an example of an FSA boundary which contains more 
than one municipality.   
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Defining the Geocoding Path - Address Geocoder 
 
 

 
 
 
The Address Geocoder is able to geocode the following types of data: 
 

 Unparsed address data 
 Parsed address data 
 Intersection data 

 
The Address Geocoder matches address input data against the information stored within the geo-
reference database.  Refer to section “Specifying Address Data Fields” for more examples of different 
types of address data.   
 
The section “Input Specifications – General Geocoding Options” can also provide functions which can be 
used to help increase the geocoding match rate and geocode more records.  This section of the 
document is useful when encountering data which is missing address information such as street type or 
street direction. 
 
 
Address Geocoder | By Municipality and FSA | Segment Data Model: This function is used to 
geocode address information using the input municipality name and FSA value as the boundaries for 
geocoding.   
 
Unparsed data 
 

Street Muni Prov Postal Code 
625 Cochrane Dr Markham ON L3R9R9 

20 Water St N Kitchener ON N2H 5A5  

 
Parsed data 
 
Address 
Number 

Street 
Name 

Street 
Type 

Street 
Direction 

Muni Prov Postal Code 

625 Cochrane Dr  Markham ON L3R9R9 
20 Water St N Kitchener ON N2H 5A5  
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Intersection data 
 

Street Muni Prov Postal Code 
YONGE ST && YORKVILLE AVE Toronto ON M4W  

 
 
 
Address Geocoder | By Municipality | Segment Data Model: This function is used to geocode address 
information using the input municipality name as the boundary for geocoding.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed data 
 

Street Muni Prov Postal Code 
625 Cochrane Dr Markham ON  

20 Water St N Kitchener ON   

 
Parsed data 
 
Address 
Number 

Street 
Name 

Street 
Type 

Street 
Direction 

Muni Prov Postal Code 

625 Cochrane Dr  Markham ON  
20 Water St N Kitchener ON   

 
 
Intersection data 
 

Street Muni Prov Postal Code 
YONGE ST && YORKVILLE AVE Toronto ON   

 
 
Address Geocoder | By FSA | Segment Data Model: This function is used to geocode to an address 
point using the FSA (Forward Sortation Area) value from the postal code as the boundary for geocoding.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 
 

Street Muni Prov Postal Code 
625 Cochrane Dr  ON L3R9R9 

20 Water St N  ON N2H 5A5 
 
Parsed 
 
Address 
Number 

Street 
Name 

Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

625 Cochrane Dr   ON L3R9R9 
20 Water St N  ON N2H 5A5 

 
Intersection 
 

Street Muni Prov Postal Code 
YONGE ST && YORKVILLE AVE  ON M4W 
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Address Geocoder and Scrubber functionality 
 
GeoPinpoint Suite offers a Scrubber function (under license) which examines the data and outputs the 
geocoded results (x, y, rcode, prescode) to the input database.  In order to receive the best possible 
Scrubber results when using the Address Geocoder, ensure that there is an input postal code for each 
record (if available).   
 
For more information on the Scrubber function, refer to section "Input Specifications - Scrubber"  
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Defining The Geocoding Path – Point Of Interest (POI) Geocoder 
 

 
  

 
The Point of Interest (POI) Geocoder is able to geocode the following types of data: 
 

 POI data 
 

 
POI Geocoder | Use Whole Name | To POI Point By Municipality and FSA: This function is used to 
geocode to Point of Interest locations by matching the whole POI name in the geo-reference database.  
The input municipality and FSA are used as the boundaries for geocoding. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CN Tower TORONTO ON M5V 2T6  

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CASINO NIAGARA   NIAGARA FALLS ON L2G 3K6  
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POI Geocoder | Use Whole Name | To POI Point By Municipality: This function is used to geocode to 
Point of Interest locations by matching the whole POI name in the geo-reference database.  The input 
municipality is used as the boundary for geocoding. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CN Tower TORONTO ON   

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CASINO NIAGARA   NIAGARA FALLS ON   

 
 
 
POI Geocoder | Use Whole Name | To POI Point By FSA: This function is used to geocode to Point of 
Interest locations by matching the whole POI name in the geo-reference database.  The FSA of the postal 
code is by GeoPinpoint Suite to select the appropriate FSA boundary for geocoding. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CN Tower  ON M5V 2T6 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CASINO NIAGARA    ON L2G 3K6 
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Note: GeoPinpoint Suite currently only stores aerodrome (airport) aliases for Whole Alias / Partial  
          Alias functions. 

 
POI Geocoder | Use Whole Alias | To POI Point By Municipality and FSA: This function is used to 
geocode to Point of Interest locations by matching the whole POI alias in the geo-reference database.  
The input municipality and FSA value are used as the boundaries for geocoding. 
 
The example we will use for ‘Use Whole Alias’ will be Guelph Airport where the alias is known as 
Guelph Air Park. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
Guelph Air Park Guelph ON N1H6H8  

 
Parsed 
 
Address 
Number 

Street Name Street Type Street 
Direction 

Muni Prov Postal 
 Code 

 Guelph Air Park   Guelph ON N1H6H8  

 
 
 
 
POI Geocoder | Use Whole Alias | To POI Point By Municipality: This function is used to geocode to 
Point of Interest locations by matching the whole POI alias in the geo-reference database.  The input 
municipality is used as the boundary for geocoding. 
 
The example we will use for ‘Use Whole Alias’ will be Guelph Airport where the alias is known as 
Guelph Air Park. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
Guelph Air Park Guelph ON   

 
Parsed 
 
Address 
Number 

Street Name Street Type Street 
Direction 

Muni Prov Postal 
 Code 

 Guelph Air Park   Guelph ON   
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POI Geocoder | Use Whole Alias | To POI Point By FSA: This function is used to geocode to Point of 
Interest locations by matching the whole POI alias in the geo-reference database.  The FSA of the postal 
code is by GeoPinpoint Suite to select the appropriate FSA boundary for geocoding. 
 
The example we will use for ‘Use Whole Alias’ will be Guelph Airport where the alias is known as 
Guelph Air Park. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
Guelph Air Park  ON N1H6H8 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 Guelph Air Park    ON N1H6H8 
 
 
 
 
 
POI Geocoder | Use Partial Name | To POI Point By Municipality and FSA: This function is used to 
geocode to Point of Interest locations by checking to see if the input POI name matches partial POI name 
in the geo-reference database.  The input municipality and FSA value are used as the boundaries for 
geocoding. 
 
The example we will use for ‘Use Partial Name’ will be UNIVERSITY OF WESTERN ONTARIO - 
BRESCIA COLLEGE where the Partial Name value is Brescia College. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
BRESCIA COLLEGE London ON N6G1H2  

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 BRESCIA COLLEGE   London ON N6G1H2  
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POI Geocoder | Use Partial Name | To POI Point By Municipality: This function is used to geocode to 
Point of Interest locations by checking to see if the input POI name matches partial POI name in the geo-
reference database.  The input municipality is used as the boundary for geocoding. 
 
The example we will use for ‘Use Partial Name’ will be UNIVERSITY OF WESTERN ONTARIO - 
BRESCIA COLLEGE where the Partial Name value is Brescia College. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
BRESCIA COLLEGE London ON   

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 BRESCIA COLLEGE   London ON   

 
 
 
 
 
 
POI Geocoder | Use Partial Name | To POI Point By FSA: This function is used to geocode to Point of 
Interest locations by checking to see if the input POI name matches partial POI name in the geo-
reference database.  The FSA of the postal code is by GeoPinpoint Suite to select the appropriate FSA 
boundary for geocoding. 
 
The example we will use for ‘Use Partial Name’ will be UNIVERSITY OF WESTERN ONTARIO - 
BRESCIA COLLEGE where the Partial Name value is Brescia College. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
BRESCIA COLLEGE   N6G1H2 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 BRESCIA COLLEGE    ON N6G1H2 
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POI Geocoder | Use Partial Alias | To POI Point By Municipality and FSA: This function is used to 
geocode to Point of Interest locations by checking to see if the input POI name matches partial POI alias 
in the geo-reference database.  The input municipality and FSA value are used as the boundaries for 
geocoding. 
 
The example we will use for ‘Use Partial Alias’ will be LONDON INTERNATIONAL AIRPORT where the 
Partial Name alias is LONDON INTERNATIONAL. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
LONDON INTERNATIONAL LONDON ON N5V1A1  

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 LONDON INTERNATIONAL   LONDON ON N5V1A1  

 
 
 
 
 
POI Geocoder | Use Partial Alias | To POI Point By Municipality: This function is used to geocode to 
Point of Interest locations by checking to see if the input POI name matches partial POI alias in the geo-
reference database.  The input municipality is used as the boundary for geocoding. 
 
The example we will use for ‘Use Partial Alias’ will be LONDON INTERNATIONAL AIRPORT where the 
Partial Name alias is LONDON INTERNATIONAL. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
LONDON INTERNATIONAL LONDON ON   

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 LONDON INTERNATIONAL   LONDON ON   
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POI Geocoder | Use Partial Alias | To POI Point By FSA: This function is used to geocode to Point of 
Interest locations by checking to see if the input POI name matches partial POI alias in the geo-reference 
database.  The FSA of the postal code is by GeoPinpoint Suite to select the appropriate FSA boundary 
for geocoding. 
 
The example we will use for ‘Use Partial Alias’ will be LONDON INTERNATIONAL AIRPORT where the 
Partial Name alias is LONDON INTERNATIONAL. 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
LONDON INTERNATIONAL  ON N5V1A1 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 LONDON INTERNATIONAL    ON N5V1A1 
 
 
 
 
 
POI Geocoder | Use POI Type | To POI Point By Municipality and FSA: This function is used to 
geocode to Point of Interest locations by matching the POI type in the geo-reference database.  The input 
municipality name and FSA are used as the boundaries for geocoding.   
 
 
Example 

NAME POI Type 
Guelph Airport CNC4 

 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CNC4 Guelph ON N1H6H8  

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CNC4   Guelph ON N1H6H8  
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POI Geocoder | Use POI Type | To POI Point By Municipality: This function is used to geocode to 
Point of Interest locations by matching the POI type in the geo-reference database.  The input 
municipality name is used as the boundary for geocoding.   
 
 
Example 

NAME POI Type 
Guelph Airport CNC4 

 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CNC4 Guelph ON   

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CNC4   Guelph ON   

 
 
 
 
POI Geocoder | Use POI Type | To POI Point By FSA: This function is used to geocode to Point of 
Interest locations by matching the POI type in the geo-reference database.  The FSA of the postal code is 
by GeoPinpoint Suite to select the appropriate FSA boundary for geocoding. 
 
 
Example 

NAME POI Type 
Guelph Airport CNC4 

 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
CNC4  ON N1H6H8 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

 CNC4    ON N1H6H8 
 
 
 
 
 
 

Note: For more examples of POI Type values – refer to Appendix 4:  Points of Interest  
          Layers 
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When geocoding POI data in GeoPinpoint Suite, the data can either be geocoded by unparsed or parsed.  
The POI data value (e.g.: CN Tower) can be stored in the unparsed address column or in the parsed 
street name column.  Refer to the examples given for the POI Geocoder (see above) for more details. 
 
The Input Specifications section (see below) will also outline how the data should be prepared, before 
using the POI Geocoder to geocode POI data. 
 
 
 
POI Geocoder and Soundex functionality 
 
GeoPinpoint Suite offers a Soundex function under license to help match POI data that maybe dirty or 
missing information and geocode these records.  The Soundex function once turned on will work by 
converting the input POI name to a Soundex key and comparing this value to POI data Soundex keys 
which are stored in the geo-reference database.  
 
For more information on the Soundex function, refer to section “Input Specifications –Soundex”  
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Defining the Geocoding Path - Postal Code Geocoder 
 

 
 
 
 
The Postal Code Geocoder is able to geocode the following types of data: 
 

 Postal Code data 
 

 
 
 
 

Hint! GeoPinpoint Suite can geocode postal code data with or without provincial information  
         (e.g.: ON for Ontario) 

   
 
 
Postal Code Geocoder | Use Postal Code | To Postal Code Point: This function is used to geocode to 
a postal code point using the input municipality name as the boundary.  This function is based on postal 
code data, therefore a postal code field is required as part of the input information.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 
 

Geoaddress Muni Prov Postal Code 
   M5V3C9 

  ON M5V3C9 

625 Cochrane Dr Markham ON L3R9R9 

625 Cochrane Dr  ON L3R9R9 

 
Parsed 
 
Address 
Number 

Street Name Street 
Type 

Street 
Direction 

Muni Prov Postal 
 Code 

      M5V3C9 

     ON M5V3C9 

625 Cochrane Dr  Markham ON L3R9R9 

625 Cochrane Dr   ON L3R9R9 
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Defining The Geocoding Path - Segment Geocoder 
 

 
 
 
The Segment Geocoder is able to geocode the following types of data: 
 

 Address data 
 Zero-address streets 

 
 
 
Segment Centroid functions 
 
 
The Segment Geocoder | Use Address | To Segment Centroid function should be used when the user 
wants to geocode to the centroid point of the street block that contains the address number.  
 
Segment Geocoder | Use Address | To Segment Centroid | By Municipality and FSA: This function 
is used to geocode to the centre point of a street segment using the input municipality name and FSA as 
the boundaries for geocoding. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

9 GRENADIER DR HAMILTON Ontario L8T4C7  

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

9 GRENADIER DR HAMILTON Ontario L8T4C7  
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Segment Geocoder | Use Address | To Segment Centroid | By Municipality: This function is used to 
geocode to the centre point of a street segment using the input municipality name as the boundary for 
geocoding. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

9 GRENADIER DR HAMILTON Ontario   

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

9 GRENADIER DR HAMILTON Ontario   

 
 
 
Segment Geocoder | Use Address | To Segment Centroid | By FSA: This function is used to geocode 
to the centre point of a street segment using the FSA portion of the input postal code as the boundary for 
geocoding.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

9 GRENADIER DR  Ontario L8T4C7 
 

Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

9 GRENADIER DR  Ontario L8T4C7 
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Street Segments functions 
 
The Segment Geocoder | Use Address | To Street Segments function should be used an address 
string was unable to be geocoded using the address geocoder.  One possible reason for this could be a 
missing street number value. 
 
To demonstrate this – we can use the example of the record: Bay St.  If Bay St has 8 segments with 
different address ranges associated with each respectively, the Street Segments function would return 
the segment centroid of the first segment found in the geo-reference database. 
 
 
 
Segment Geocoder | Use Address | To Street Segments | By Municipality and FSA: This function is 
used to geocode to a series of street segments using the input municipality name and FSA as the 
boundaries for geocoding.  For window’s desktop version, only the first segment is returned as the result.  
The API version is able to let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

GRENADIER DR HAMILTON Ontario L8T4C7  

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

 GRENADIER DR HAMILTON Ontario L8T4C7  

 
 
 
Segment Geocoder | Use Address | To Street Segments | By Municipality: This function is used to 
geocode to a series of street segments using the input municipality name as the boundary for geocoding.  
For window’s desktop version, only the first segment is returned as the result.  The API version is able to 
let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

GRENADIER DR HAMILTON Ontario   

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

 GRENADIER DR HAMILTON Ontario   
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Segment Geocoder | Use Address | To Street Segments | By FSA: This function is used to geocode a 
series of street segments using the FSA portion of the input postal code as the boundary for geocoding.  
For window’s desktop version, only the first segment is returned as the result.  The API version is able to 
let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

GRENADIER DR  Ontario L8T4C7 
 

Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

 GRENADIER DR  Ontario L8T4C7 
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Zero Street Segments functions 
 
The Segment Geocoder | Use Address | To Zero Street Segments function should be used to 
geocode to streets which do not contain any addressing on their segments.  Therefore, the entire street 
and its associated segments all have address ranges of zero (0).  This function is useful for geocoding to 
those new segments found in new subdivisions but have not yet been updated with addressing.  
 
NOTE: The coordinate will be placed to the centroid of the zero-addressed segment 
 
 
Segment Geocoder | Use Address | To Zero Street Segments | By Municipality and FSA: This 
function is used to geocode to a series of street segments using the input municipality name and FSA as 
the boundaries for geocoding.  For window’s desktop version, only the first segment is returned as the 
result.  The API version is able to let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
 
Segment Geocoder | Use Address | To Zero Street Segments | By Municipality: This function is used 
to geocode to a series of street segments using the input municipality name as the boundary for 
geocoding.  For window’s desktop version, only the first segment is returned as the result.  The API 
version is able to let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
 
Segment Geocoder | Use Address | To Zero Street Segments | By FSA: This function is used to 
geocode a series of street segments using the FSA portion of the input postal code as the boundary for 
geocoding.  For window’s desktop version, only the first segment is returned as the result.  The API 
version is able to let the user retrieve all of the segments GeoPinpoint Suite geocoded to.   
 
 
If the user selects the geocoding path, 
Segment Geocoder >> Use Address >> To Zero Street Segments 
 
they will be prompted to add a column to their database called ‘TotalDistZeroStSegs(m)’, after the start 
button is selected in the geocode tab. If a record geocodes to an unaddressed street (and its associated 
street segments), the field will be populated with the total distance of all the unaddressed segments for 
that street name; not to be confused with the individual segment length for the particular segment that it 
gets geocoded to.
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Defining The Geocoding Path – Boundary Geocoder 
 

 
 
 
The Boundary Geocoder is able to geocode the following types of data: 
 

 FSA data 
 PPN data 
 Municipal centroid data 

 
 
Boundary | Use FSA | To FSA Centroid: This function is used to geocode to the centroid of the FSA 
area using the FSA portion of the input postal code as the boundary.  This function is based on postal 
code data, therefore a postal code field (FSA LDU) is required as part of the input information.   
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

  ON M5V3C9 
625 Cochrane Dr Markham ON L3R9R9 
625 Cochrane Dr  ON L3R9R9 

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

    Ontario L8T4C7 
625 Cochrane Dr Markham ON L3R9R9 
625 Cochrane Dr  ON L3R9R9 
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Boundary | Use Municipality | To PPN Points: This function is used to geocode to a Populated Place 
Name (PPN) point using the input municipality name. 
 
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

 Bobcaygeon ON  
 Flamborough ON   

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

   Bobcaygeon ON  
   Flamborough ON   

 
 
 
 
 
 
 

Note: Province information has to be provided with each record otherwise the record will  
          not geocode to PPN point. FSA information should be provided to help the software 
          distinguish between same name PPN values (e.g.: Mount Pleasant which occurs  

 
Boundary | Use Municipality | To Municipal Centroid: This function is used to geocode to a municipal 
centroid point using the input municipality name. 
  
Examples of records which can be geocoded using this function are: 
 
Unparsed 

 
Geoaddress Muni Prov Postal Code 

 Toronto ON  
 Vancouver BC   

 
 

 
Parsed 
 

Address 
Number 

Street  
Name 

Street 
Type 

Muni Prov Postal 
Code 

   Toronto ON  
   Vancouver BC   

 
 
 
 
 
 
 
 

          seven times in Ontario). 

Note: Province information has to be provided with each record otherwise the record will  
          not geocode to Municipal centroid. FSA information should be provided to help the  
          software distinguish between same name muni values (e.g.: Hamilton which  
          occurs twice in Ontario – once as a city and as a township). 
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Default geocoding functions 
 
 
If the user decides not to select a geocoding function from the ‘Define Geocoding Path’ dialog and clicks 
the OK button – the following message box will appear: 
 

 
 
By clicking the Yes button, the geocoding function Address Geocoder | By Municipality | Segment 
Data Model will automatically be selected.  Refer to “Defining the Geocoding Path - Address Geocoder” 
for more information. 
 
Clicking the No button, will not select any of the geocoding functions. 
 
 
 
 
Single Geocoder Installations – Default geocoding functions 
 
Address Geocoder 
 
If the user has installed just the address geocoder module, and decides not to select a geocoding function 
from the ‘Define Geocoding Path’ dialog and clicks the OK button - the following message will appear: 
 

 
 
The above message box informs the user that the Address Geocoder | By Municipality | Segment Data 
Model function has been initialized. 
 
 
POI Geocoder 
 
If the user has installed just the POI geocoder module, and decides not to select a geocoding function 
from the ‘Define Geocoding Path’ dialog and clicks the OK button - the following message will appear: 
 

 
 
The above message box informs the user that the POI Geocoder | Use Whole Name | To POI Point By 
Municipality function has been initialized. 
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Postal Code Geocoder 
 
If the user has installed just the postal code geocoder module, and decides not to select a geocoding 
function from the ‘Define Geocoding Path’ dialog and clicks the OK button - the following message will 
appear: 
 

 
 
The above message box informs the user that the Postal Code Geocoder | Use Postal Code | To Postal 
Code Point function has been initialized. 
 
 
 
Segment Geocoder 
 
If the user has installed just the segment geocoder module, and decides not to select a geocoding 
function from the ‘Define Geocoding Path’ dialog and clicks the OK button - the following message will 
appear: 
 

 
 
The above message box informs the user that the Segment Geocoder | Use Address | To Segment 
Centroid | By Municipality function has been initialized. 
 
 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 75 

Function Definitions 
 
In order to view the definition associated with each geocoding function: 
 

1. Hover the mouse over the appropriate geocoding function 
2. Read the information in the Function Description text box displayed at the bottom of the ‘Defining 

Geocoding Path’ dialog 
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Data Sources 
 
Data Sources - Target Database  
 
GeoPinpoint Suite processes records from database tables.  The database containing the table is 
referred to as the target database, and the table being geocoded at any given time is referred to as the 
target database table.   
 
These tables within the database can hold one or more of the following pieces types of data: 
 

 Unparsed address data 
 Parsed address data 
 POI data 
 Postal code data 
 FSA data 
 PPN data 
 Municipality data 

 

 
 
 
The input database can be one of the following file types: 
 

 Access 97/2000 database 
 Oracle 8i/9i database 
 dbf III, IV, V 
 FoxPro 2.0, 2.5, 2.6, 3.0 
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MDB button 
 
Clicking the MDB… button will open the ‘Open Target Database’ dialog allowing a user to select an      
MS Access database (97/2000) to geocode.  
 

 
 
Navigate using the ‘Open Target Database’ dialog and select the MS Access database that is to be 
geocoded. 
 
 
 
 
ODBC Files 
 
Clicking the ODBC… button will allow the user to select one or all of the following file types: Oracle 8i/9i, 
dbf, FoxPro. 
 

 To geocode a Oracle file (8i/9i) -  refer to Appendix 7: Sample ODBC Connection 
 To geocode a dbf file (III, IV, V) – refer to Appendix 9: Geocoding dBase (*.dbf) files 
 To geocode a FoxPro file (2.0, 2.5, 2.6, 3.0) – refer to Appendix 10: Geocoding FoxPro files 
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Data Sources - Table/SQL 
 
The Table/SQL window contains the name of the target database table that contains the records to be 
geocoded.   
 

 
 
 
 
Selecting a Table 
 
After selecting the database – the ‘Pick a Table’ dialog will 
appear and allow the user to select the table that they wish to 
geocode.  
 
The Data button (Select Table…) can be used to view a list of 
tables in the specified target database and the user can select 
the desired table directly from this list to ensure that a valid 
table name is entered. 
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Output Columns 
 
GeoPinpoint Suite produces a geocoding result output which is written to fields within the target database 
table.  The information supplied by GeoPinpoint Suite includes the X and Y coordinates for each 
geocoded record, a result code, and a precision code.  Refer to Appendix 2: Interpretation of Result Code 
(Rcode) and Appendix 3: Interpretation of Precision Code (Prescode) for more information on the output 
values: result code and precision code. 
 
GeoPinpoint Suite also offers automatic population of the output combo boxes on the Output 
Specifications tab if the output column names match the names that the software is looking for.  Refer to 
section “Output Specifications” for a listing of what these column names are. 
 
 
 
Access Databases 
 
The output columns necessary of capturing GeoPinpoint Suite geocoding results can either be added by 
the user or by the software. 
 
If the user wishes to add the columns themselves – the columns should follow this format: 
 

Field Name Description Data Type Field Size 
X Longitude Number Double 
Y Latitude Number Double 

Rcode Result Code Number Long Integer 
Prescode Precision Code Number Long Integer 

Table 1: Target database (Access) table fields required for geocoding results output 
 
 
 
 
 
 

Note: The output columns do not have to be labeled: x, y, rcode, prescode – but the user must then 
select these user-defined output columns themselves on the Output Specifications tab.  Refer to 
Output Specifications section for more information. 

 
 
 
If you want the software to add these columns for you, select the table which does not contain these 
output columns and the following message box will appear: 
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ODBC Databases (Oracle, dbf, FoxPro) 
 
For output column information for ODBC files, refer to the Appendix which highlights this information: 
 

 For Oracle files - refer to Appendix 7: Sample ODBC Connection 
 For dbf files – refer to Appendix 9: Geocoding dBase (*.dbf) files for output column information 
 For FoxPro files – refer to Appendix 10: Geocoding FoxPro files 

 
 
 
 
 
Using SQL 
 
Within the Table/SQL window, the user has the option of using an SQL statement to query out specific 
records for geocoding.  The SQL statement may be typed manually or pasted into the window from 
another source (Example: Select * from <table_name>).  The SQL statement will be executed as soon as 
the user selects the Next button or moves the cursor from the Table/SQL window.   
 
 
 
 
 
 

Note: The time required for the SQL statement to be executed depends on the database size, the 
database location, the speed of the computer, and the SQL statement itself. 

 
The information in this window is verified with the information in the Target Database window.  Any error 
with respect to the syntax of the SQL statement, the target database table name, or the fields within the 
target database table will result in an error message when the user selects the Next button or moves the 
cursor from the Table/SQL window. 
 
 
 

 Next: The user can move forward through the geocoding steps to the Input Specifications tab 
using the Next button.   

 
 Exit: This button can be used to terminate GeoPinpoint Suite at any time.  
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Defining Input Specifications 
 
Input Specifications allows the user to specify address data fields used for geocoding and geocoding 
options.   
 

 
 

 
 

 Back: The user can move backward through the geocoding steps to the Data Sources tab using 
the Back button.   

 
 Next: The user can move forward through the geocoding steps to the Input Specifications tab 

using the Next button.   
 

 Reset: The user can clear the contents of the combo and option boxes if changes are necessary. 
 

 Exit: This button can be used to terminate GeoPinpoint Suite at any time.  
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Specifying Address Data Fields 
 

 
 
Geocoding an Unparsed Address 
 
An unparsed address represents data that may contain relevant components of a street address, which 
may include a street number, an apartment or a suite number, street name, street type, and a street 
direction. This information is concatenated and stored in one column (e.g.: geoaddress) 
 
GeoPinpoint Suite can geocode the following kinds of unparsed information: 
 

 Unparsed address 
 Unparsed intersection 
 Unparsed POI 
 Unparsed Postal code 
 Unparsed Segment (segment centroid, street segment) 
 Unparsed FSA 
 Unparsed PPN 
 Unparsed Muni centroid 

 
 
 
 
 

Note: Refer to the above geocoding function sections (address, POI, etc for examples of each of 
          these records) 
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Looking at the above snapshot of GeoPinpoint Suite – Input Specifications, geocoding unparsed address 
information requires the use of the following fields: 
 

 Unparsed address 
 Municipality* 
 Province 
 Postal Code* 

 
*The Municipality value must be populated when using a function which geocodes <By Municipality>. 
*The Postal Code value must be populated when using a function which geocodes <By FSA>. 
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Unparsed Address: This heading represents data that may contain relevant components of a street 
address, which may include a street number, an apartment or a suite number, street prefix, street name, 
street type, and a street direction. This field must be represented as a text field in the target database 
table and currently handles only Canadian data. There is no restriction on the size of the text field. 
 
If the address cannot match to the geo-reference database, it is possible that a component of the address 
is incorrect 
 
Possible problems with unparsed address values 
Address Component Possible problems 
Street Number Problem: 

Address number does not exist in the range stored in the geo-reference 
database for that particular street 
 
Solution: 
Use Relax/Address functions on Input Specifications tab:  
• Closest Address Tolerance 
• Opposite Side of Street 
 
Refer to Input Specifications section to learn more information on how to use 
these functions. 

Street Prefix Problem: 
Street prefix is missing or is incorrect for the respective street 
 
Solution: 
Use Relax/Address functions on Input Specifications tab 
• Relax Matching on Street Prefix 
 

Street Name Problem: 
Street name is not spelled correctly or is incorrect 
 
Solution: 
If record does not geocode: 
• Examine record inside the table and verify correctness 
• Use Geocode to Street Alias function – this street may have a street alias 

or be known by a former name 
 
Refer to Input Specifications section to learn more information on how to use 
these functions. 

Street Type Problem: 
Street type is missing or is incorrect for the respective street 
 
Solution: 
Use Relax/Address functions on Input Specifications tab 
• Relax Matching on Street Type 
 

Street Direction Problem: 
Street direction is missing or is incorrect for the respective street 
 
Solution: 
Use Relax/Address functions on Input Specifications tab 
• Relax Matching on Street Direction 
 

 
 Note: GeoPinpoint Suite currently does not match apartment or suite numbers to the geo-reference 

          database. 
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Municipality: This heading represents a municipality field (city, town, village) in order to refine geocoding.  
This field must be represented as a text field in the target database table and currently handles only 
Canadian data. There is no restriction on the size of the text field.  This column must be populated when 
using a geocoder function <By Municipality>. 
 
Possible problems with municipality values 
Address Component Possible problems 
Municipality Problem: 

Missing or incorrect municipality value 
 
Solution: 
• If the data is not present in the target database table it may be derived 

from postal code information using the Lookup Municipality via Postal 
code option located on the General Geocoding Options tab.   

• Check spelling of municipality value. 
 

 Problem: 
French municipality name is translated into English. 
 
Solution: 
The geo-reference database only stores municipality values as they appear in 
data sources.  Therefore, English equivalent values to French municipality 
values are not stored or used within GeoPinpoint Suite. 

 
 
 
 
 
Province: This heading represents a provincial field in order to refine geocoding.  This field must be 
represented as a text field in the target database table and currently handles only Canadian data. There 
is no restriction on the size of the text field.  This field must be populated with the correct province value 
because address information could be the same between provinces.   
 
If the records within a database fall within one province, the user can utilize the Use Constant for 
Province option located on the General Geocoding Options tab and input the single value of the province.   
 
 
 
The following represents acceptable values that can be populated within the province column: 
 
Abbreviation Full Province/Territory Name  Abbreviation Full Province/Territory Name
AB Alberta  NU Nunavut 
BC British Columbia  ON Ontario 
MB Manitoba  PE Prince Edward Island 
NB New Brunswick  QC / PQ Quebec 
NL / NF Newfoundland and Labrador  SK Saskatchewan 
NS Nova Scotia  YT Yukon Territory 
NT Northwest Territories    
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Postal Code: This heading represents a postal code field.  Postal Codes may be comprised of either 6-
digit or 7-digit string i.e.”N0N 1H0” or ”N0N1H0”.  This field must be represented as a text field in the 
target database table and currently handles only Canadian data. There is no restriction on the size of the 
text field.  This column must be populated when using a geocoder function <By FSA>. 
 
 
 
 
 
 
 

Note: The GeoPinpoint Suite also has enhanced functionality, which recognizes when a “O” is being  
          used incorrectly when a “0” (zero) is required.  GeoPinpoint Suite will still be able to geocode  
          these kinds of postal code records. 
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Geocoding a Parsed Address 
 

 
 
A parsed address represents data that may contain relevant components of a street address, which may 
include a street number, an apartment or a suite number, street name, street type, and a street direction. 
This information is stored in separate columns for each component (e.g.: address number, street name, 
street type, street direction) 
 
GeoPinpoint Suite can geocode the following kinds of parsed information: 
 

 Parsed address 
 Parsed POI 
 Parsed Postal code 
 Parsed Segment (segment centroid, street segment) 
 Parsed FSA 
 Parsed PPN 
 Parsed Muni centroid 

 
 
 
 
 

Note: Refer to the above geocoding function sections (address, POI, etc for examples of each of 
          these records) 
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Looking at the above snapshot of GeoPinpoint Suite – Input Specifications, geocoding parsed address 
information requires the use of the following fields 
 

 Street Number 
 Street Prefix 
 Street Name 
 Street Type 
 Street Prefix Type 
 Street Suffix Type 
 Street Pre-Direction 
 Street Suf-Direction 
 Suite 
 Municipality* 
 Province 
 Postal Code* 

 
*The Municipality value must be populated when using a function which geocodes <By Municipality>. 
*The Postal Code value must be populated when using a function which geocodes <By FSAi>. 
 
 
 
 
 

Note: All of the above fields for parsed geocoding are not necessary.  This depends on the type of  
          parsed address records being geocoded. 
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Street Number: This heading represents a house/building number field.  The Street Number field 
requires numeric data and the field must be stored as a long integer. 
 
 
 
Street Prefix: This heading represents a field that may contain the following prefixes, Des, De La, De L’ 
and often proceed the actual street name.  This field must be represented as a text field in the target 
database table and currently handles only Canadian data. There is no restriction on the size of the text 
field. 
 
 
 
 
 

Note: If the prefix is part of the street name value, use the ‘Parse out Prefix from Street Name’  

 
 
Street Type: This heading represents a field that may contain one street type. It represents the field in 
the target database table that contains the street type.  For a list of valid street types, see Appendix 5 – 
Valid Street Type and Street Direction Data, Table 5.  This field must be represented as a text field in the 
target database table and currently handles only Canadian data. There is no restriction on the size of the 
text field. 
 
 
 
Street Prefix Type & Street Suffix Type: This heading represents a field that may contain two street 
types.  To access both drop down lists, the user must select the Use Street Prefix and Suffix Type option 
located on the General Geocoding Options tab.  This field must be represented as a text field in the target 
database table and currently handles only Canadian data. There is no restriction on the size of the text 
field. 
 
 
 
Street Direction: This heading represents a field that may contain geographical directions.  The sample 
address does not contain a street direction, but an example could be N, which would indicate North.  For 
a list of valid street direction entries, see Appendix 5 – Valid Street Type and Street Direction Data, Table 
6.  Select the Use Street Pre-Direction function to allow for pre-directional information.   
 
This field must be represented as a text field in the target database table and currently handles only 
Canadian data. There is no restriction on the size of the text field. 
 
 
 
Suite: This heading represents a field that contains a number, a letter, or a combination of both that 
represents an apartment, a suite, or a unit of a building.  Although this field may contain only numbers, 
they must be stored as text data. 
 
This field must be represented as a text field in the target database table and currently handles only 
Canadian data. There is no restriction on the size of the text field. 
 
 
 
 
 

          function. 

Note: GeoPinpoint Suite currently does not match apartment or suite numbers to the geo-reference 
          database. 
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Municipality: This heading represents a municipality field (city, town, village) in order to refine geocoding.  
This field must be represented as a text field in the target database table and currently handles only 
Canadian data. There is no restriction on the size of the text field.  This column must be populated when 
using a geocoder function <By Municipality>. 
 
Possible problems with municipality values 
Address Component Possible problems 
Municipality Problem: 

Missing or incorrect municipality value 
 
Solution: 
If the data is not present in the target database table it may be derived from 
postal code information using the Lookup Municipality via Postal code option 
located on the General Geocoding Options tab.   
 

 Problem: 
French municipality name is translated into English. 
 
Solution: 
The geo-reference database only stores municipality values as they appear in 
data sources.  Therefore, English equivalent values to French municipality 
values are not stored or used within GeoPinpoint Suite. 

 
 
 
Province: This heading represents a provincial field in order to refine geocoding.  This field must be 
represented as a text field in the target database table and currently handles only Canadian data. There 
is no restriction on the size of the text field.  This field must be populated with the correct province value 
because address information could be the same between provinces.   
 
If the records within a database fall within one province, the user can utilize the Use Constant for 
Province option located on the General Geocoding Options tab and input the single value of the province.   
 
 
 
The following represents acceptable values that can be populated within the province column: 
 
Abbreviation Full Province/Territory Name  Abbreviation Full Province/Territory Name
AB Alberta  NU Nunavut 
BC British Columbia  ON Ontario 
MB Manitoba  PE Prince Edward Island 
NB New Brunswick  QC / PQ Quebec 
NL / NF Newfoundland and Labrador  SK Saskatchewan 
NS Nova Scotia  YT Yukon Territory 
NT Northwest Territories    
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Postal Code: This heading represents a postal code field.  Postal Codes may be comprised of either 6-
digit or 7-digit string i.e.”N0N 1H0” or ”N0N1H0”.  This field must be represented as a text field in the 
target database table and currently handles only Canadian data. There is no restriction on the size of the 
text field.  This column must be populated when using a geocoder function <By FSA>. 
 
 
 
 
 

Note: The GeoPinpoint Suite also has enhanced functionality, which recognizes when a “O” is being  
          used incorrectly when a “0” (zero) is required.  GeoPinpoint Suite will still be able to geocode  
          these kinds of postal code records. 
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Geocoding Options 
 
Geocoding options for address, municipality, postal code and provincial input are available using the four 
tabs to the right of the field matching headings.  The tabs include General, Relax/Address, 
PrecisionCode.  Clicking on the tab name allows the user to access the particular options of each tab.   
 
General Geocoding Options 
 
The General Geocoding Options tab offers the user the ability 
to utilize some basic geocoding options.  Each option, with its 
description, is listed below.   
 
Use Un-Parsed Address Field: 
 
 The user will check this option if the geocoding is to be 
performed using a single field in the table that contains all the 
components of the address.  (See the description of parsed 
and unparsed data in the previous section called “Specifying 
Address Data Fields – Geocoding an Unparsed Address”).  If 
this option is selected, the individual component headings 
(i.e.: street number, street name, etc.) will not be accessible 
as these appear during parsed geocoding. 

  
 

 
Parse out Prefix from Street Name: 
 
Sets the option to parse out the street name prefix from the street name input to match the contents of the 
geo-reference database.   
 
Use this function when performing parsed geocoding on records, which contains one of the following 
prefixes:  
 
 
Prefix 

 
Add # 

Pre 
Street 
Type 

Street  
Name 

Street 
Dir 

Street 
Type 

 
Muni 

 
Prov

D’ 8875 RUE D'URFÉ   CHARLESBOURG QC 
DE 1159 CH DE MONTRÉAL O  MASSON-ANGERS QC 
DE L’ 8467 RUE DE L'ODYSSÉE   CHARLESBOURG QC 
DE LA 757 RUE DE LA MINE   ACTON VALE QC 
DE LE 0 RUE DE LE BRISS   VAL-SENNEVILLE QC 
DES 4110 PLACE DES ROITELETS   CHARLESBOURG QC 
DU 3136 RANG DU HAUT ST FRANÇOIS   LAVAL QC 
DU L' 2586 RUE DU L’ECUSSON   SAINT-LAZARE QC 
L' 19 RUE L'ANGLAIS   PETIT ROCHER NB 
LA 31  LA FRANCE  RD BRAMPTON ON 
LES 10100 BOUL LES GALERIES D’ANJOU  ANJOU QC 
THE 1417  THE QUEENSWAY   ETOBICOKE ON 
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Use Street Prefix and Suffix Type: 
 
If the user is geocoding a table with parsed data that contains two street type fields (a street prefix type 
and a street suffix type), enabling this option allows the user to input their two street type fields into 
GeoPinpoint Suite.  This option eliminates the user’s need of taking their two existing street type fields 
and combining them into one. 
 
Use Street Pre-Direction:  
 
Sets the option to allow for GeoPinpoint Suite to recognize pre-direction and suf-direction address 
information (e.g.: SOUTH RIDGE DR SE) when both have a value. 
 
 
Use Constant for Province 
When the target database table contains records for only one province, the two-letter abbreviation for that 
province may be entered here (case insensitive).  The accepted abbreviations for Canadian provinces 
and territories are listed in Table 2. 
 
This feature is particularly useful if there is no provincial field in the target database table and it contains 
records that are all in the same province.  This option still can be used however, even if there is a 
provincial field.  If this is the case and a provincial field was also identified in the headings on the left side 
of the dialog, that field will be ignored in lieu of the data entered here. 
 

Province Value Province Value 
Alberta AB / AL Nunavut NU 
British Columbia BC / BT / BR Ontario ON / OT 
Manitoba MB /MN Prince Edward Island PI / PE 
New Brunswick NB Quebec QC / PQ / QB / QU 
Newfoundland and 
Labrador 

NF / NL Saskatchewan SK 

Nova Scotia NS Yukon Territory YT / YK 
Northwest Territories NT / NW   

 
 
Use Intersection Delimiter: 
 
GeoPinpoint Suite geocodes intersection information through the address geocoder.  Intersection data 
can only be geocoded during unparsed geocoding sessions. 
 
The textbox beside the Use Intersection Delimiter function is used to specify the intersection delimiter that 
is represented in the data (e.g.: ##, **, etc..).  If this value is left blank, the default value of “&&” will be 
used.   
 
Example: Yonge St && Bloor St W 
 
 
 
 
 

Note: GeoPinpoint will not recognize the use of the word ‘AND’, such as Yonge St and Bloor St W  
          because address information can also contain the word ‘AND’.  An example of this could be 234  
          Concession Rd 2 and 3. 

 
Intersection data is broken down into it’s respective streets and each is looked at individually.  If there is 
data missing (street type, prefix) from either address, you may have to use the relax functions to fill in this 
information.  Refer to section “Relax/Address Geocoding Options”. 
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Lookup Municipality via Postal Code: 
 
This option should be used when the municipality column in the target database table has missing or 
incorrect values.  Postal code data is also required for this function to work properly as GeoPinpoint Suite 
will determine the municipality name based on the postal code coordinates for that record. 
 
If postal code data is present and the municipality field contains data, GeoPinpoint Suite will try to find a 
match using that data first.  It will only derive a municipality using postal code information, if this first 
attempt to find a match fails. The derived municipalities using this function are used for geocoding 
purposes only, therefore the target database table is never altered. 
 
Example: 

Geoaddress Municipality Province Postal Code 
801 King St W  ON M5V3C9 

 
In the above example, using the ‘Lookup Municipality via Postal Code’ function will find that Toronto is the 
appropriate municipality value and will be used to geocode the record. 
 
 
 
 
Geocode to Street Alias: 
 
This option allows GeoPinpoint Suite to search the geo-reference database for alternative street names 
for streets that have more than one correct identifying name.  For example, a road may be known as 
Broadway Avenue, and Highway 9.  While the name Broadway Avenue may be in the geo-reference 
database street field, the target database table may have a record with the address on Highway 9.  By 
selecting this option, GeoPinpoint Suite is able to make a match by finding Highway 9 in the geo-
reference database Street Alias field. 
 
GeoPinpoint Suite searches the Street Alias field and Former Street name fields in the geo-reference 
database. 
 
Example 
 
Original Record 

Geoaddress City Prov 
3972 Regional Rd 7 Markham ON 

Former Name (Street Alias) 
Geoaddress City Prov 

3972 Highway 7 Markham ON 
 
Original Record 

Geoaddress City Prov 
11400 Hurontario St Brampton ON 

Former Name (Street Alias) 
Geoaddress City Prov 

11400 Highway 10 Brampton ON 

Note: This function should be used with <By Municipality…> functions.
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Relax/Address Geocoding Options 
 
The Relax/Address Geocoding Options tab offers the user the 
ability to allow GeoPinpoint to relax the rules of how it 
matches an address.  GeoPinpoint can optionally ignore 
certain components of an address within the table if the data 
is missing or the data is determined to be questionable.  Each 
option, with its description, is listed below.   
 
  
 
 
 
 
 
Relax Matching on Street Type: 
 
Enabling this option allows geocoding to proceed when all 
address components match except the street type.  This 
option produces reliable results but is intended for use when 
street types are missing or unreliable in the target database 
table.  Refer to Appendix 5: Valid Street Type and Street 
Direction Data for these values. 

 
 
 
 

  
 

Note: The Soundex function will only appear if 
license keys have been entered for them. 

 
 
Relax Matching on Street Direction: 
 
Enabling this option allows geocoding to proceed when all address components match except the street 
direction.  Street direction is a vital component to an address so this option should only be used if street 
directions are missing or unreliable in the target database table. Refer to Appendix 5: Valid Street Type 
and Street Direction Data for these values. 
 
 
Relax Matching on Street Prefix: 
 
Enabling this option allows geocoding to proceed when all address components match except the street 
prefix.  Street prefix is a unique component to an address so this option should only be used if street 
prefixes are missing or unreliable in the target database table. 
 
 
  
 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 96 

Refine Address by Postal Code: 
 
This option is useful in the case where more than a single street segment is a possible match to an 
address.  Enabling this option, allows GeoPinpoint Suite to compare the location of a records postal code 
to all street segments that are a potential geocoding solution.   
 
GeoPinpoint Suite will select the segment that is closest to the postal code for that record.  If this option is 
selected, a field must be entered in the Postal Code drop down list. 
 
This option is particularly useful if Relax Matching on Street Type, Relax Matching on Street Direction, or 
Relax Matching on Street Prefix has been selected. 
 
 
 
 
 

Note: This function will not work on records that have the correct address information.  Therefore, any of 

 
 
Closest Address Tolerance: 
 
This option should be used when you are confident that the address information (name, muni, etc) is 
correct but are unsure about the address number value. 
 
GeoPinpoint Suite will attempt to geocode addresses to the closest address number within the user-
defined tolerance (value entered in textbox).  The user is required to specify a tolerance value that will be 
used to define a range above and below the original address number in that record.  The address number 
values that are searched will even or odd depending on the number entered. Therefore, a value entered 
of 10 will result in a search of +2, -2, +4, -4, +6, -6, +8, -8, +10, 10. 
 
For example, if the original address that did not geocode was 500 Yonge St, and the user specified a 
closest address tolerance of 100, then GeoPinpoint Suite would geocode that record to the closest 
address number that it could find between 400 and 600 Yonge St.  If GeoPinpoint Suite cannot find 
another address number within the closest address tolerance, then the record will remain ungeocoded.   
 
 
 
 
 

          the Input Specification functions (Relax, etc) are not used on these records. 

Note: If the option is selected, but no tolerance is defined, GeoPinpoint Suite will not perform this  

 
If GeoPinpoint Suite locates two address numbers, one above and one below the original address 
number, that have the same absolute difference from the original address number, then GeoPinpoint 
Suite will geocode to the higher of the two.  From the example above, if GeoPinpoint Suite located two 
closest addresses in the geo-reference database, 450 Yonge St and 550 Yonge St, both having an 
absolute difference of 50 from the original address  of 500 Yonge St, then GeoPinpoint Suite would 
geocode the record to 550 Yonge St. 
 
When this option is selected, GPP will prompt the user if they would like to add the column ‘ActAddNum’ 
to their database. If a record geocodes within the closest address tolerance, the field will then be 
populated in the database with the actual street number that was geocoded to. 
 
 
 
 

          functionality. 

Hint! This function can be used with the function ‘Opposite Side of the Street’ which will provide  
         address number values (+1, -1) to GeoPinpoint Suite for searching.  Therefore, the  
        ‘Closest Address Tolerance’ function will be used first and then the ‘Opposite Side of the Street’  
         function. 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 97 

Opposite Side of the Street: 
 
The Opposite side of the street geocoding function will attempt to geocode using a tolerance value (e.g.: 
2  +1/-1) to the input address number, if an address did not geocode successfully. 
  
  

Input Address Geocoded Address 
625 Cochrane Dr 624 and 626 Cochrane Dr 

 
When this option is selected, GPP will prompt the user if they would like to add the column ‘ActAddNum’ 
to their database. If a record geocodes within the opposite side of the street tolerance, the field will then 
be populated in the database with the actual street number that was geocoded to. 
 
 
 
 
 
 
 
 

Hint! This function can be used with the function ‘Closest Address Tolerance’ which will provide  
         address number values (+2, -2, +4, -4, etc) to GeoPinpoint Suite for searching.  Therefore, the  
        ‘Closest Address Tolerance’ function will be used first and then the ‘Opposite Side of the Street’  
         function. 
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v6.3 and Greater Functions 
 
Soundex: 
 
The Soundex module for GeoPinpoint Suite Windows/ActiveX is a new function for v6.3 and newer 
release clients.  This module is an algorithm that uses fuzzy logic to help geocode POI names, which 
suffer from spelling variations, abbreviations, difference in case and/or are incomplete. 
 
The proposed methodology for using Soundex:  
 

 Geocode the records in the database with the POI geocoder first, then  
 Turn on Soundex functionality to try and match more records in the second pass. 

 
 
Currently the Soundex module for GeoPinpoint Suite will perform the following: 
 

 Help geocode to POI names 
 Match one or multiple POI names simultaneously 

 
 
Examples of Soundex: 
 

Original word Input word Output word 
Toronto City Hall Toronto City Hall Toronto City Hall 
Toronto City Hall City Hall of Toronto Toronto City Hall 
Toronto City Hall Holl of Sity Toronto Toronto City Hall 
Konberg Comperg Konberg 

 
The Soundex Module for GeoPinpoint Suite also includes: 
 

 Ability to match to street names and municipalities 
In previous releases, GeoPinPoint included a soundex function; however, the user did not 
have control over the tolerance to which the soundex was operating on (a default value of 
65 was set, which reflects a suitable tolerance for name matching). This new feature 
allows the user to input a custom tolerance value for soundex geocoding. 
 
The user can input any two digit number as a tolerance value (1-99). ‘99’reflects a match 
that is closer to an exact name match, and ‘1’ reflects a match that is far from an exact 
name match. 

 
  Please note that using both street name and municipality soundexing at the same 
  time can slow down geocoding times quite significantly. It is recommended to use 
  the functions in two separate geocoding passes 
 

 Set thresholds for Soundex matching 
 Include the Soundex score as part of the output 

 
 
 
 
 
Note: This function will only be visible in the GeoPinpoint Suite GUI when a license key has been    
          entered. 
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Rural Pcode to PPN 
 
This function requires that both the FSA centroid 
and Populated Place Name (PPN) centroid 
geocoder functions are selected.  Once this 
function is selected, the software will recognize 
when a postal code contain a second digit equal to 
zero (0) which flags it as a rural postal code.  It will 
then try and geocode this record using the input 
municipality value to PPN before it falls back to 
geocoding to the rural FSA centroid. 
 
This function is useful where a PPN point may be 
closer to a city/town boundary than the rural FSA 
centroid. 
 
NOTE: This function also works with the muni 
centroid function on.  Therefore, the record will 
attempt to be geocoded to PPN, then muni and 
lastly FSA centoid. 
 
 
Postal Code Precision Code 
 
This function should be used in conjunction with the 
postal code geocoder, if the user wishes to only 
geocode certain postal code precision codes.  This 
functionality allows the user to specify that only 
certain postal codes should be geocoded of a 
certain precision code(s).   
 
Note: If the postal code geocoder is used without 
selecting any of the postal code precision codes on 
this tab – then it will geocode to all 6 (i.e.: 100 – 
600) precision codes. 
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Defining Output Specifications 
 
Output Specifications allows the user to specify the output fields for the coordinates (longitude, latitude), 
result code, and precision code data. Records can be geocoded in batch or interactively. 
 

 
 
 
 
 

 Back: The user can move backward through the geocoding steps using the Back button.   
 

 Next: The user can move forward through the geocoding steps using the Next button.   
 

 Exit: This button can be used to terminate GeoPinpoint Suite at any time. 
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Specifying Output Fields  
 
The drop down combo boxes along the left side of the Output Specifications tab represent the output 
column fields in the target database.  The user must match their field names in the target database to 
required fields used in the geocoding process.   
 
 
GeoPinpoint Suite dynamically adds the following output fields to the target database: 
 

 Longitude: Contains the X coordinate of the geocoding output in decimal degrees.  The number 
of decimal places in the output coordinate is determined by the field type specifications in the 
target database table. The longitude will always be a negative number for Canadian data 
because Canada is located west of the prime meridian. 

 
 Latitude: Contains the Y coordinate of the geocoding output in decimal degrees.  The number of 

decimal places in the output coordinate is determined by the field type specifications in the target 
database table. The latitude will always be a positive number for Canadian data because Canada 
is located north of the equator. 

 
 Result Code: The result code is a 9-digit result code indicating what portions of the address 

matched during the geocoding process.  Refer to Appendix 2: Interpretation of Result Code 
(Rcode) for more information regarding result codes. 

 
 Precision Code: The precision code is a numeric precision code indicating what criterion was 

used to geocode a record.  Refer to Appendix 3: Interpretation of Precision Code (Prescode) for 
more information regarding precision codes. 

 
 
 
 
 
 

Hint! Data types for the above output columns can be found in the section “Data Sources – Output  
         Columns”. 

 
 
As mentioned in the section “Data Sources - Output Columns”, GeoPinpoint will automatically populate 
the output column combo boxes from the input database on the Output Specifications tab if they match 
any of the names listed in the following table: 
 
Combo box Name Accepted Column Name Value 
Longitude X / longitude / long 
Latitude Y / latitude / lat 
Result Code Rcode 
Precision Code Prescode 
 
 

Note: All column names are acceptable for the above output columns – but if the user-defined column  
          name is not found in the above table, the user will have to select their column name on the Output  
          Specifications tab. 
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Incorrect Output Column Data types 
 
For Access databases, if the output column data types are incorrect, GeoPinpoint will post the following 
message and will exit  
 

 
 
 
For dbf and FoxPro databases, if the user does not specify a x or y column but instead have a longitude 
or latitude column name (or something else that is representative), the following message box will be 
displayed: 
 

 
 
 
 
 
 
 

Note: Even though this message box appears, the database can still be able to be geocoded    
          after the user selects the appropriate x, y combo box values on the Output Specifications  
          tab. 
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Output Options 
 
Output Options offers a user the ability to alter how GeoPinpoint Suite handles the output coordinate 
data.  Each option, with its description, is listed below. 
 
 
Overwrite Existing Coordinates: If this option is selected then the user selected geocoding output fields 
are overwritten. If the target database table has not been geocoded before, this option can remain 
unselected. 
 
 
If the database has been geocoded before, the user has two options:  
 

1. Select Overwrite Existing Coordinates and GeoPinpoint Suite will overwrite any values in the user 
selected output fields.   

 
2. Do not select Overwrite Existing Coordinates and GeoPinpoint Suite will skip any records that 

have values in the output fields and only geocode records that contain all blanks or zeros in the 
user selected output fields.   

 
This option is particularly advantageous if a table has been geocoded with a high-level precision 
in a previous geocoding session, and the table is being re-geocoded lower level precision 
geocoding session (i.e. Relax on street type and direction).  In this case, it would be desirable to 
maintain the coordinates of the first geocoding session for the records that were successfully 
geocoded with a high level of precision, rather than risk losing precision by re-geocoding them 
with the relax options selected. 

 
 Offset from Centreline (m): The offset value specified here is the distance in metres that the 
point will be placed from the centerline street data during geocoding.  An offset of 10 m is 
average for most roadways.  The maximum value accepted is 50m. 

 
 Inset from Centreline (m): The inset value specified here is the distance in metres that the 
point will be placed from the end of a segment during geocoding.  An offset of 10 m is 
average for most roadways.   This function is useful for those coordinates which are 
associated with addresses that fall on the start or end of a segment and fall near an 
intersection.  The resulting coordinate looks as if it associated with a different street than the 
one being geocoded. The maximum value accepted is 50m. 
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Geocode Options 
 
The Geocode Options offers the user the ability to interact with their geocoding session in GeoPinpoint 
Suite.  Each option, with its description, is listed below. 
 
 
Interactive Geocoding is Required: This option offers an alternative to batch processing un-parsed 
addresses.  When the interactive geocoding option is selected, GeoPinpoint Suite will pause at each 
record that it is unable to geocode using with the defined parameters and will offer the user three choices 
to continue with geocoding: 
 

 To make changes to the address and retry geocoding the record 
 To skip the record 
 To exit the interactive mode and finish geocoding in batch mode. 

 
If a change is made to an address during an interactive geocoding session, the change will be reflected in 
the original target database table.  These are permanent changes that remain after the geocoding 
process is complete. 
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     Geocoding 
 
Once geocoding options have been defined the user can launch the geocoding session.  Geocoding 
results are updated in the “Result’s Window” as records are being geocoded. 
 

 
 
 
 
Results Window 
 
The number of records geocoded by each geocoding method is dynamically updated and can be viewed 
in the Results Window.  These statistics are produced as the geocoding session processes which the 
progress bar below the total number of records tracks.   
 
When data is “geocoded”, co-ordinates can be transferred into a Geographic Information Systems (GIS) 
such as MapInfo, ArcInfo, ArcView and other software systems that support the importation of geographic 
co-ordinate locations.  
 
To import the GeoPinpoint Suite geocoded results into a GIS: 
 

 For importing into MapInfo Professional - refer to Appendix 11: Import geocoded data into 
MapInfo Professional 

 For importing into ArcView 3.x - refer to Appendix 12: Import geocoded data into ArcView v3.x 
 For importing into ArcGIS - refer to Appendix 13: Import geocoded data into ArcGIS  

 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 106 

 
 Back: The user can move backward through the geocoding steps using the Back button.   

 
 Start: Starts the geocoding session. 

 
 Stop: Terminates a current geocoding session. Clicking the Start button again can restart the 

geocoding session.   
 

 Exit: Terminates GeoPinpoint Suite at any time. 
 
While GeoPinpoint Suite is geocoding, any of the three previous tab headings, Data Sources, Input 
Specifications, or Output Specifications, may be viewed without affecting the geocoding session. 
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     Conclusion 
 
DMTI Spatial’s geocoder, GeoPinpoint Suite, is able to attach geographic coordinates to records in a 
database by matching the data from certain fields in the target database against an existing geo-
reference database.  The geo-reference database is made up of digital street geometry, address ranges, 
postal coordinates, and other point-location coordinates, which are updated regularly by DMTI Spatial to 
ensure the greatest possible accuracy.  After the data is geocoded, it can be transferred into a geographic 
information system such as AutoCAD Map, MapInfo, ArcInfo, ArcView or other system that supports 
spatial data. 
 
GeoPinpoint Suite is able to geocode address data, intersection data, and points of interest data as long 
as the data is stored in an Oracle 8i/9i, Access database (*.mdb), dBase or FoxPro file.  GeoPinpoint 
Suite offers a great deal of flexibility in data entry because it handles French-style addressing as 
efficiently as English-style addressing and it is able to geocode unparsed or parsed addresses.  In 
addition, GeoPinpoint Suite gives the user many options to improve geocoding accuracy, such as the 
option to refine by postal code, and to obtain higher matching rates, such as the ability to “relax” on street 
type, street direction, or street prefix.   
 
The staff at DMTI Spatial is committed to helping all of its clients realize the potential of spatial solutions.  
This document has been written to provide all users with the information needed to effectively use 
GeoPinpoint Suite.  It is noted, however, that each user has unique circumstances that may pose 
challenges to geocoding in addition to those covered in this document.  DMTI Spatial welcomes any 
further questions users may have and any comments they would like to make regarding this, or any other, 
product or service provided by DMTI Spatial. 
 
 
DMTI Spatial can be contacted at: 
 
DMTI Spatial Inc. 
625 Cochrane Drive, 3rd Floor 
Markham, Ontario 
L3R 9R9   Canada 
 
Telephone: 905-948-2000 
Toll Free:  1-877-477-DMTI (3684) 
Fax:  905-948-9404 
 
URL:  www.dmtispatial.com 
Email:  info@dmtispatial.com 
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   Appendix 1: Example Version Conflict snapshots 
 
When installing GeoPinpoint Suite for Windows, the software installs it’s own set of libraries (dlls), which 
may cause a version conflict dialog to appear.  GeoPinpoint Suite may be using older version of these 
library files in it’s software compared with what is installed on the users computer. 
 
The version conflict dialog box tells the user which library files being copied from the GeoPinpoint Suite 
software are older than the ones that currently reside on the computer.  The user is recommended by the 
dialog to keep the existing file by selecting the Yes button.  The user also has the option of selecting the 
No or No to All button(s) as well. 
 
Version Conflict Message – Example #1  

 

 
 
 

Version Conflict Message – Example #2 
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Version Conflict Message – Example #3 
 

 
 
 
 
Version Conflict Message – Example #4 
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Version Conflict Message – Example #5 
 

 
 

 
 
 
Version Conflict Message – Example #6 
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Appendix 2: Interpretation of Result Code (Rcode) 
 
When GeoPinpoint Suite geocodes, it generates a 9-digit result code, which helps the user to understand 
how the record was processed and the degree to which the record was successfully geocoded. A 9-digit 
result code, such as 111101001, is written to the Result Code (i.e.: Rcode) field or alternatively, to a user- 
specified field in the target database table. Each digit represents one component of the geocoding 
process as defined in Chart 1. 
 
 
For example, 111101001 represents 
 
 

1 1 1 1 0 1 0 0 1 
 
 
 

STATUS TYPE STREET POSTAL 
CODE / 

PPN 

MUNI 
NAME 

RELAX PROV 
REFINED 

PARSER 

OK SEGMENT 
ADDRESS 

ORIGINAL CANMAP 
HI 

NOT 
FOUND 

ON 
STREET 

TYPE 

NOT 
FOUND 

NOT 
FOUND 

OK 
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Chart 1: Individual digit definitions of 9-digit result codes. 
Format:  D D D D D D D D D
           
STATUS           
   OK  1         
   FAIL  2         
           
TYPE           
   NOT FOUND / NOT APPLICABLE   0        
   BY SEGMENT ADDRESS   1        
   BY INTERSECTION   2        
   BY POINT OF INTEREST   3        
   BY POSTAL CODE   4        
   BY MUNICIPAL CENTROID   5        
   BY FSA CENTROID   6        
   BY POPULATED PLACE NAME   7        
   BY CLOSEST ADDRESS   8        
  BY SEGMENT   9        
           
STREET           
   NOT FOUND / NOT APPLICABLE    0       
   ORIGINAL    1       
   ZERO ADDRESSING    2       
   STREET ALIAS (FORMER    
   NAME) 

   3       

   SUBSTITUTED    4       
   LOOK FOR SEGMENT INFO    5       
   SEARCH BY SOUNDEX    6       
   SEARCH BY SCRUBBER    7       
           
POSTAL CODE            OR POPULATED PLACE 

NAME / POINT OF 
INTEREST1 

         

   NOT FOUND / NOT APPLICABLE NOT FOUND / NOT APPLICABLE    0      
   CANMAP HI NTDB    1      
   CANMAP LO CANMAP HI    2      
   LDU Centroid CANMAP LO    3      
   FSA Centroid POSTAL CODE BLOCK FACE    4      
   PPN Centroid POSTAL CODE EA CENTROID    5      
    MUNICIPAL CENTROID    6      
 CANADIAN GEOGRAPHIC 

NAMES DATABASE 
   7      

           
SEGMENT           
   SEGMENT CENTROID      8      
   TO SEGMENTS (LOWEST   
   ADDRESS) 

    9      

           
MUNICIPALITY NAME           
   NOT FOUND / NOT APPLICABLE      0     
   ORIGINAL      1     
   FROM POSTAL CODE      2     
   BY FSA BOUNDARY      4     
   SUBSTITUTED      5     
   FROM MUNICIPAL ALIAS LIST      6     
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  D D D D D D D D D
RELAX           
   NOT FOUND / NOT APPLICABLE       0    
   ON STREET TYPE       1    
   ON STREET DIRECTION       2    
   ON STREET PREFIX       3    
   ON STREET TYPE & STREET 
   DIRECTION 

      4    

   ON STREET TYPE & STREET  
   PREFIX 

      5    

   ON STREET DIRECTION &  
   STREET PREFIX 

      6    

   ON STREET TYPE & STREET  
   DIRECTION & STREET PREFIX 

      7    

           
PROVINCE           
   NOT FOUND / NOT APPLICABLE        0   
   ORIGINAL        1   
   SUBSTITUTED        2   
   CUSTOM LOOKUP        3   
           
REFINED           
   NOT FOUND / NOT APPLICABLE         0  
   REFINED BY POSTAL CODE         1  
   REFINED BY FSA         2  
   REFINED BY RURAL POSTAL  
   CODE (MUNI / FSA) 

        3  

   REFINED BY RURAL POSTAL  
   CODE (MUNI ) 

        4  

           
PARSER           
   NOT FOUND / NOT APPLICABLE          0 
   OK          1 
   FAIL          2 
 
1 The result code for POI is similar to PPN except that the value of 7 (CANADIAN GEOGRAPHIC  
   NAMES DATABASE) is not used.
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Result Code Digit Definitions 
 
 
STATUS (1st digit  e.g.: 111101001) 
Code Value 

 
Definition 

1 OK Record was geocoded  
2 FAIL Record was not geocoded 

 
 
TYPE (2nd digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 

 
2) “Not Applicable”, implies that an address 

component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value will display a zero for 
the fifth digit of the result code. 

1 BY SEGMENT ADDRESS Record was geocoded using the address geocoder  
2 BY INTERSECTION Record was geocoded to intersection using the address 

geocoder (see Intersection Delimiter)  
3 BY POINT OF INTEREST Record was geocoded to Point of Interest using the POI 

geocoder  
4 BY POSTAL CODE Record was geocoded to postal code using the Postal 

Code geocoder  
5 BY MUNICIPAL 

CENTROID 
Record was geocoded to municipal centroid using the 
Boundary geocoder  

6 BY FSA CENTROID Record was geocoded to FSA centroid using the 
Boundary geocoder  

7 BY POPULATED PLACE 
NAME 

Record was geocoded to PPN point using the Boundary 
geocoder  

8 BY CLOSEST ADDRESS Records was geocoded to the closest address using the 
address geocoder  

9 BY SEGMENT Records was geocoded to the address segment centroid 
using the Segment geocoder  
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 STREET (3rd digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 

 
2) “Not Applicable”, implies that an address 

component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value would display a zero 
for the fifth digit of the result code. 

1 ORIGINAL Record was geocoded successfully because input street 
name matched to the geo-reference database.   

2 ZERO ADDRESSING Record was geocoded to a street whose segments are all 
zero addressed (i.e.: address range is 0 to 0) 

3 STREET ALIAS 
(INCLUDES FORMER 
NAME) 

When user selects the option ‘Geocode to Street Alias’ 
the record will geocode to street aliases (refer to page 
87). 

4 SUBSTITUTED User information may contain invalid characters such a % 
or $.  If GPP Suite encounters such invalid characters it 
will strip them out in the standardization process in order 
to geocode. 

5 LOWEST ADDRESS Record was geocoded using the Segment geocoder  
6 SEARCH BY SOUNDEX Record was geocoded using the assistance of the GPP 

Suite Soundex function  
7 SEARCH BY SCRUBBER Record was geocoded using the assistance of the GPP 

Suite Scrubber function  
 
 
POSTAL CODE (4th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 

 
2) “Not Applicable”, implies that an address 
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component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value would display a zero 
for the fifth digit of the result code. 

1 CANMAP HI Record was geocoded to a block-face1 representative 
point from CanMap streets (High precision).  High 
precision indicates that the postal code has been 
geocoded to CanMap Streetfiles, which contain the 
address (midpoint of the address range in CPC data) of 
the postal code.  

2 CANMAP LO Record was geocoded to a block-face1 representative 
point from CanMap streets (Lower precision).  Low 
precision indicates that the postal code has been 
geocoded to CanMap "closest address" with the 
tolerance set to 10.   

3 LDU Centroid Record was geocoded to postalcode representative point 
which is from the Platinum Postal Suite (PPS) Local 
Delivery Unit (LDU) centroid. 

4 FSA Centroid Record was geocoded to postalcode representative point 
which is from the Platinum Postal Suite (PPS) Forward 
Sortation Area (FSA) centroid. 

5 PPN Centroid Record was geocoded to Populated Placename (PPN) 
centroid. 

 
1 The definition for block face was taken from the Statistics Canada document: Postal Code 

Conversion File January 2003 Postal Codes Reference Guide.  
 

A block face is one side of a street between two consecutive features intersecting that street.  
The points are set back a perpendicular distance of either 10, 5, or 1 meter(s) from the street 
centre line to ensure that all points have unique coordinates, and are located in the correct 
block and on the correct side of the street. 

 
2 The definition for enumeration area was taken from the Statistics Canada document:  Postal 

Code Conversion File January 2003 Postal Codes Reference Guide.  
 

An enumeration area (EA) is the geographic area canvassed by one census representative.  
An EA is composed of one or more adjacent blocks. 

 
 
POPULATED PLACE NAME (PPN) / POINT OF INTEREST (POI) (4th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 
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2) “Not Applicable”, implies that an address 
component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value would display a zero 
for the fifth digit of the result code. 

 
1 NTDB PPN: Record was geocoded to a PPN point, which 

represents the centroid of a National Topographic 
Database (NTDB) feature. 
 
POI:  Record was geocoded to a POI point, which 
represents the centroid of 1:50 000 NTDB feature or 
placed via Orthorectified photo 
 

2 CANMAP HI PPN: Record was geocoded to PPN point, which 
represents the coordinate of a CanMap Major 
intersection, City Hall or Enhanced Point of Interest 
(EPOI) (i.e.: manually placed and verified).  
 
POI: Record was geocoded to a POI point, which 
represents a block-face representative point from 
CanMap streets - High precision. 
 

3 CANMAP LO PPN: Record was geocoded to PPN, which is attached to 
a coordinate of a CanMap nearest intersection (i.e.: 
manually placed and verified). 
 
POI: Record was geocoded to POI point, which 
represents a block-face representative point from 
CanMap streets - Lower precision. 
 

4 POSTAL CODE BLOCK 
FACE 

PPN: Record was geocoded to PPN point, which 
represents the coordinate of a postal code block-face1 
centroid 
 
POI: Record was geocoded to POI point, which 
represents a postal Code - Block-face representative 
point 
 

5 POSTAL CODE EA 
CENTROID 

PPN: Record was geocoded to PPN point, which 
represents the coordinate of a postal code EA2 centroid 
 
POI: Record was geocoded to POI point, which 
represents a postal Code - EA Centroid / FSA Centroid 
 

6 MUNICIPAL CENTROID PPN: Record was geocoded to PPN point, which 
represents the coordinate of a Statistics Canada 
municipal centroid or a designated places centroid 
 
POI: Record was geocoded to POI point, which 
represents a municipal centroid 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 118 

7 CANADIAN GEOGRAPHIC 
NAMES DATABASE 

PPN: Record was geocoded to PPN point, which 
represents a coordinate from the Canadian Geographic 
Names Database 
 
POI: N/A 

 
1. The definition for block face was taken from the Statistics Canada document:  Postal Code 

Conversion File January 2003 Postal Codes Reference Guide.  
  

A block face is one side of a street between two consecutive features intersecting that 
street.  The points are set back a perpendicular distance of either 10, 5, or 1 meter(s) 
from the street centre line to ensure that all points have unique coordinates, and are 
located in the correct block and on the correct side of the street. 

 
2. The definition for enumeration area was taken from Statistics Canada document: Postal Code 

Conversion File January 2003 Postal Codes Reference Guide.   
 

An enumeration area (EA) is the geographic area canvassed by one census 
representative.  An EA is composed of one or more adjacent blocks. 

 
 
SEGMENT (4th digit  e.g.: 111101001) 
Code Value 

 
Definition 

8 SEGMENT CENTROID Record was geocoded using the Segment geocoder | To 
Segment centroid function.  The input address number 
locates the appropriate segment and geocodes to the 
segment centroid. 

9 TO SEGMENTS (LOWEST 
ADDRESS) 

Record was geocoded using the Segment geocoder | To 
Street Segments.  Input address records without address 
numbers are geocoded to the first segment of the street 
and then to the lowest address. 

 
 
 
MUNICIPALITY NAME (5th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 

 
2) “Not Applicable”, implies that an address 

component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value would display a zero 
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for the fifth digit of the result code. 
1 ORIGINAL When GeoPinpoint Suite matches an input municipality 

using the Statistics Canada municipality list, the fifth digit 
of the result code will become a 1. 

2 FROM POSTAL CODE Municipality information contained in record was matched 
using the function ‘Lookup Municipality via Postal Code’.  

4 BY FSA BOUNDARY Municipality information contained in record was matched 
by using FSA boundary. 

5 SUBSTITUTED User information may contain invalid characters such a % 
or $.  If GPP Suite encounters such invalid characters it 
will strip them out in the standardization process in order 
to geocode. 

6 FROM MUNICIPAL ALIAS 
LIST 

DMTI Spatial has created a list of municipal aliases that 
allows the user to geocode databases that contain place 
names that do not have individual Census Subdivision 
boundaries as defined by Statistics Canada.  If the input 
municipality does not match then GeoPinpoint Suite will 
check it against an alias list. If the record geocodes, then 
the fifth digit of the result code, will be a 6. 

 

  
RELAX (6th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

No relax functions were selected 

1 ON STREET TYPE Function ‘Relax Matching on Street Type’ was selected  
2 ON STREET DIRECTION Function ‘Relax Matching on Street Direction’ was 

selected  
3 ON STREET PREFIX Function ‘Relax Matching on Street Prefix’ was selected  
4 ON STREET TYPE & 

STREET DIRECTION 
Function ‘Relax Matching on Street Type’ was selected 
AND  
Function ‘Relax Matching on Street Direction’ was 
selected 

5 ON STREET TYPE & 
STREET PREFIX 

Function ‘Relax Matching on Street Type’ was selected 
AND 
Function ‘Relax Matching on Street Prefix’ was selected 

6 ON STREET DIRECTION 
& STREET PREFIX 

Function ‘Relax Matching on Street Direction’ was 
selected 
AND 
Function ‘Relax Matching on Street Prefix’ was selected 

7 ON STREET TYPE & 
STREET DIRECTION & 
STREET PREFIX 

Function ‘Relax Matching on Street Type’ was selected 
AND 
Function ‘Relax Matching on Street Direction’ was 
selected  
AND 
Function ‘Relax Matching on Street Prefix’ was selected 
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PROVINCE (7th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

The result codes generated by GeoPinpoint Suite do not 
currently distinguish between “Not Found” or “Not 
Applicable” and a zero is used for both cases. 
 
Depending on the data input there are two possible 
interpretations: 
 

1) “Not found”, implies that an address component 
was entered, such as a municipality, but that the 
municipality was not found in the geo-reference 
database. 

 
2) “Not Applicable”, implies that an address 

component was not entered.  For example, if no 
municipality value is selected in the Input 
Specifications section of the dialog, then all 
records without this value would display a zero 
for the fifth digit of the result code. 

1 ORIGINAL Record was geocoded as GPP Suite found the provincial 
value in the geo-reference database 

2 SUBSTITUTED Provincial information in record was standardized and 
then used to make a match in the Georef 

3 CUSTOM LOOKUP This is for customers who have customized geo-
reference databases. 

 
 
REFINED (8th digit  e.g.: 111101001) 
Code Value 

 
Definition 

0 NOT FOUND /  
NOT APPLICABLE 

‘Refine By Postal Code’ option was not selected 

1 REFINED BY POSTAL 
CODE 

Value occurs when ‘Refine By Postal Code’ option is 
selected 

2 REFINED BY FSA Address was geocoded using both the municipality and 
the FSA value. Municipality value result code is found in 
the 5th digit of the result code. 

3 REFINED BY RURAL 
POSTAL CODE (MUNI / 
FSA) 

Rural pcode to PPN function was used which indicates 
that a rural FSA was identified and the record geocoded 
to PPN (or Muni).  The PPN (or Muni) value was matched 
using a municipality and FSA value to select the correct 
PPN (or Muni) value. 

4 REFINED BY RURAL 
POSTAL CODE (MUNI) 

Rural pcode to PPN function was used which indicates 
that a rural FSA was identified and the record geocoded 
to PPN.  The PPN (or Muni) value was matched using a 
municipality value to select a PPN value.  NOTE: The 
correct (intended) PPN (or Muni) may not have been 
selected because a FSA value was not provided to help 
decide between duplicate values. 
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PARSER (9th digit  e.g.: 111101001) 
Code Value Definition 

 
0 NOT FOUND /  

NOT APPLICABLE 
Value is possible when geocoding parsed data which 
does not require the parser 

1 OK Parser parsed record successfully 
2 FAIL Parser was unable to parse record successfully 
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Appendix 3: Interpretation of Precision Code (Prescode) 
 
 
Each time GeoPinpoint Suite successfully geocodes a record, a precision code is written to the Precision 
Code (i.e.: Prescode) field (or alternatively, other user-specified field) in the target database table.  This 
code is an indicator of the spatial precision of the geocoded point.  The precision code is generated 
based on the result code and an interpolation code. 
 
 
 
 
Interpretation of Precision Code 
 
An interpolation code is an indicator for the address point status that describes whether or not an address 
was geocoded to a specific point location that exists in the geo-reference database or to an interpolated 
address.  GeoPinpoint Suite will not return these interpolation codes of 0, 20 or 21 to the user but will 
reference them through certain specific precision codes  (e.g.: Precision codes: 10, 15, 30). 
 

Interpolation Code 0 - indicates that the address point is interpolated and its existence in the 
real world is not guaranteed;  

 
Interpolation Code 20 - indicates that the address point is the start or end point of an original 
street segment, and it most likely exists in the real world;  

 
Interpolation Code 21 - indicates the address point is both the starting and the end point of the 
corresponding street segment (i.e. there is only one address point on the street segment), and 
the location of this point has been relocated to the centre of the segment.  This address point also 
most likely exists in the real world. 
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Precision Code 
 
Precision code values calculated based on the geocoding method are shown in Chart 2. 
 
Chart 2: Definitions of precision codes. 
 Precision Code 
Not Geocoded (Result Code is greater or equal 
to 200000000) 

0 

  
Geocoded By Street Name (using Muni and 
FSA boundaries): 

5 

  
Geocoded by Street Name (using Muni or FSA 
boundaries) 

 

    With interpolation code 0: 10 
   With interpolation code 20: 15 
   With interpolation code 21: 30 

    From Address Point Data 35 
  
Geocoded by Closest Address (Muni or FSA): 40 
Geocoded by Closest Address (Muni and 
FSA): 

45 

  
Geocoded by Street Alias (Includes Former 
Name) (using Muni and FSA boundaries): 

55 

  
Geocoded by Street Alias (Includes Former 
Name) (using Muni or FSA boundaries): 

 

    With interpolation code 0: 60 
   With interpolation code 20: 65 
   With interpolation code 21: 70 

    From Address Point Data 75 
  
Geocoded by Point of Interest (POI)  
    Centroid of 1:50 000 NTDB feature or placed 
    via Orthorectified photo 

81 

    Block-face representative point from   
    CanMap streets - High precision 

82 

    Block-face representative point from  
    CanMap streets - Low precision 

83 

    Postal Code - Block-face representative  
    point 

84 

    Postal Code - EA Centroid / FSA Centroid 85 
    Municipal Centroid 86 
  
Geocoded by Intersection 90 
  
Geocoded by Postal Code  
    CanMap Street High Precision 100 
    CanMap Street Low Precision 200 
    LDU Centroid 300 
    FSA Centroid 400 
    PPN Centroid 500 
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Geocoded to Segment Centroid 900 
Geocoded to Street Segment 950 
  
Geocoded to zero address 960 
  
Populated Place Name (PPN) Centroid 1050 
Municipal Centroid 1100 
FSA Centroid 2100 
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Appendix 4: Points of Interest Layers 
 
GeoPinpoint Suite currently has the capability to geocode to the Points of Interest (POI) layers produced 
by DMTI Spatial, if the appropriate option is selected in the GeoPinpoint Suite dialog prior to commencing 
the geocoding operation.  These layers and their descriptions are outlined in Table 4. 
 

If geocoding to points of interest is desired, then the Use Un-Parsed Address Field option must be 
selected, and the names of the points of interest must be entered in the address field of the target 
database table. 
 
GeoPinpoint Suite is able to geocode unparsed addresses and points of interest (and also intersection 
data) at the same time, as long as the same specified address field is used to store all the data.  Parsed 
address data cannot be processed at the same time as points of interest (or intersection) data. 
 
Note: When geocoding data by POI Name on the Input Specifications tab: 
 
 Un-parsed data: Select the POI Name for the combo box Un-parsed address 
      Parsed data: Select the POI Name for the combo box Street Name. 
 
GeoPinpoint Suite can geocode to a point of interest using the functions listed under the Define 
Geocoding Path.  If an attempt to geocode to a point of interest is unsuccessful, the first line of action 
should be to double check that the name of the point of interest in the target database table is complete 
and accurately spelled. 
 
There are several points of interest layers that DMTI Spatial maintains that are not included in the 
GeoPinpoint Suite geo-reference database and as such, are not available for geocoding.  The reason for 
these exclusions lies in the lack of standardized naming for these points.   
 
Note: The layers not available are: Car Pool Lots, Weigh Stations, Toll Booths, Transit Stops, and Retail 
         Postal Outlets. 
 
 
Table 4: Points of Interest layers available for geocoding. 
 
LAYER NAME ABBREVIATION DESCRIPTION 
Education edu The Education layer includes Elementary, High Schools, 

Colleges, Cégeps and Universities across Canada. 
Health Care hcr Health Care facilities include Hospitals, Long-Term Care 

Centers, Nursing Stations, Outpatient Clinics and 
Community Health Centers across Canada. 

Car Rental  car This layer includes the following Car Rental Agencies; 
Avis, Budget, Discount, Enterprise, Hertz, National and 
Thrifty. 

Accommodation acc The Accommodation layer includes hotels across 
Canada. 

Border Crossings 
and Customs Offices 

bor Border Crossings and Customs Offices include 
independent offices, subordinate offices, service sites, 
and warehouses.  The information was obtained from: 
Canada Customs and Revenue Agency (www.ccra-
adrc.gc.ca) 

Golf Courses glf There are approximately 2000 golf courses in Canada.  
This layer contains both Private and Public golf courses 
as well as their locations, phone numbers and number of 
holes. 
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Police Stations pol Police Stations contain approximately 2000 records and 
include Police forces such as OPP, QPP, municipal 
police forces, RCMP and the Military Police. 

Tourist POIs tou Tourist Information contains approximately 5000 records 
and includes categories such as Art Galleries, 
Attractions, Fishing Resorts, Historic Sites, Science 
Centre Tourist Information and Zoos. 

Financial Institutions  fin The Financial Institutions layer includes financial 
institutions belonging to one of the following three 
groups: (1) Banks, (2) Credit Unions and Caisses 
Populaires, (3) Trust Companies, Loan Companies, and 
Other Deposit-Taking Institutions. 

Gasoline Service 
Stations  

gas The Gasoline Service Stations layer is comprised of six 
different gas companies: Husky, Irving, 
PetroCanada, Pioneer, Shell, and Sunoco. Pioneer and 
Sunoco gas stations are provided for Ontario 
only. 

Ski Centers ski The Ski Centers layer is comprised of over 200 skiing 
facilities across Canada. 

Shopping Centers shp The shopping centers layer is comprised of shopping 
centres/malls for Canada. 

Cinemas cin The cinema layer contains cinemas across Canada. 

Fire Stations fre The Fire Stations layer includes fire stations in the 
provinces of Ontario, Quebec, British Columbia, Alberta, 
and Saskatchewan. 

Building Names bld The Building Names layer includes building names and 
building types. 

 
 
In addition to the listed POI layers, the user can also geocode to a variation of DMTI Spatial’s Aerodrome 
(AER) file that contains airports, waterdromes, heliports and airfields.  Due to the names that appear in 
the standard naming field, DMTI Spatial has enhanced the Aerodrome file to be utilized by GeoPinpoint 
Suite, by adding in aliases and four digit airport codes (where source data was available).  For instance, 
when attempting to geocode to aerodromes identified in Table 5, the user may enter the data seen under 
Name 1, Name 2 or Name 3. 
 
 
Table 5: Aerodrome sample data. 
 
NAME 1 NAME 2 NAME 3 
Toronto/Lester B. Pearson Intl Lester B Pearson International Airport CYYZ 
Medicine Hat Medicine Hat Airport CYXH 
Alma Terrain d'aviation d'Alma CYTF 
Vancouver Intl Vancouver International Airport CYVR 
Yellowknife Yellowknife Airport CYZF 
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Appendix 5: Valid Street Type and Street Direction Data 
 
The street types that are valid entries for geocoding parsed data with GeoPinpoint Suite are listed in 
Table 6.  The Street Type column contains the full name of each street type.  Both French and English 
types are listed.  The column labeled “CanMap® Street Type” lists the CanMap® abbreviations for each 
type.  The CanMap® street type corresponds to the standard abbreviations used by Canada Post.  The 
language column distinguishes between street types in French (F) and street types in English (E). 
 
Table 7 lists the valid entries for street direction for parsed data.  The first column names the direction in 
full, and the second column denotes an appropriate abbreviation.  Any of the full names or abbreviations 
may be used to obtain successful matches. 
 
If a street type that is not listed in Table 6 occurs in a target database table, and parsed address 
geocoding is desired, then that street type should be included in the field containing the street name, and 
the field containing street types should be left blank for that record. 
 
Table 6: Valid Street Types and Abbreviations. 
 
Street Type CanMap Street Type Language  Street Type CanMap Street Type Language
Abbey ABBEY E  Cours COURS F 
Acres ACRES E  Court CRT E 
Allée ALLÉE F  Cove COVE E 
Alley ALLEY E  Crescent CRES E 
Autoroute AUT F  Croissant CROIS F 
Avenue AV F  Crossing CROSS E 
Avenue AVE E  Cul-de-sac CDS E 
Bay BAY E  Dale DALE E 
Beach BEACH E  Dell DELL E 
Bend BEND E  Diversion DIVERS E 
Boulevard BLVD E  Downs DOWNS E 
Boulevard BOUL F  Drive DR E 
By-Pass BYPASS E  Échangeur ÉCH F 
Byway BYWAY E  End END E 
Campus CAMPUS E  Esplanade ESPL E 
Cape CAPE E  Estates ESTATE E 
Carré CAR F  Expressway EXPY E 
Carrefour CARREF F  Extension EXTEN E 
Centre C F  Farm FARM E 
Centre CTR E  Field FIELD E 
Cercle CERCLE F  Forest FOREST E 
Chase CHASE E  Freeway FWY E 
Chemin CH F  Front FRONT E 
Circle CIR E  Gardens GDNS E 
Circuit CIRCT E  Gate GATE E 
Close CLOSE E  Glade GLADE E 
Common COMMON E  Glen GLEN E 
Concession CONC E  Green GREEN E 
Corners CRNRS E  Grounds GRNDS E 
Côte CÔTE F  Grove GROVE E 
Cour COUR F  Harbour HARBR E 
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Street Type CanMap Street Type Language  Street Type CanMap Street Type Language
Heath HEATH E  Pointe POINTE F 
Heights HTS E  Port PORT E 
Highlands HGHLDS E  Private PVT E 
Highway HWY E  Promenade PROM E 
Hill HILL E  Quai QUAI F 
Hollow HOLLOW E  Quay QUAY E 
Île ÎLE F  Ramp RAMP E 
Impasse IMP F  Rang RANG F 
Inlet INLET E  Range RG E 
Island ISLAND E  Ridge RIDGE E 
Key KEY E  Rise RISE E 
Knoll KNOLL E  Road RD E 
Landing LANDNG E  Rond-point RDPT F 
Lane LANE E  Route RTE E 
Limits LMTS E  Row ROW E 
Line LINE E  Rue RUE F 
Link LINK E  Ruelle RLE F 
Lookout LKOUT E  Run RUN E 
Loop LOOP E  Sentier SENT F 
Mall MALL E  Square SQ E 
Manor MANOR E  Street ST E 
Maze MAZE E  Subdivision SUBDIV E 
Meadow MEADOW E  Terrace TERR E 
Mews MEWS E  Terrasse TSSE F 
Montée MONTÉE F  Thicket THICK E 
Moor MOOR E  Towers TOWERS E 
Mount MOUNT E  Townline TLINE E 
Mountain MTN E  Trail TRAIL E 
Orchard ORCH E  Turnabout TRNABT E 
Parade PARADE E  Vale VALE E 
Parc PARC F  Via VIA E 
Park PK E  View VIEW E 
Parkway PKY E  Village VILLGE E 
Passage PASS E  Villas VILLAS E 
Path PATH E  Vista VISTA E 
Pathway PTWAY E  Voie VOIE F 
Pines PINES E  Walk WALK E 
Place PL E  Way WAY E 
Place PLACE F  Wharf WHARF E 
Plateau PLAT E  Wood WOOD E 
Plaza PLAZA E  Wynd WYND E 
Point PT E     
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Table 7: Valid Street Directions. 
 
Street Direction Abbreviation 
East E 
Est E 
Nord N 
NordEst NE 
NordOuest NO 
North N 
NorthEast NE 
NorthWest NW 
Ouest O 
South S 
SouthEast SE 
SouthWest SW 
Sud S 
SudEst SE 
SudOuest SO 
West W 
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Appendix 6: Geocoding Sequence 
 
Throughout this document, each option in GeoPinpoint Suite is discussed and an effort has been made to 
clarify the order and under which circumstances GeoPinpoint Suite will perform each operation.  The 
following list is a summary of the sequence of events. 
 

After pressing the Start button, GeoPinpoint Suite will first evaluate the geocoding targets selected on the 
Geocoding Path tree.  If any of them are selected, the target database table will be geocoded using these 
methods.  If none of these are selected, the default path will be used which currently is set to geocode to 
address point(s) based on the segment data model using municipal boundaries. 
 
These are the geocoding sequence steps for GeoPinpoint Suite v5.x: 
 
The geocoding sequence is determined by the priority in the geocoding path tree.  For currently 
implemented geocoding targets, if all of the targets are selected, its order will be in the following list and if 
some targets are not selected, these steps will be simply skipped. 
 
1.   Geocoding to Address point based on street segment data model using municipality boundary; 
 
           Function: Address Geocoder | By Municipality and FSA | Segment Data Model 
           Function: Address Geocoder | By Municipality | Segment Data Model 
 
2.   Geocoding to Address point based on street segment data model using FSA boundary; 
 
 Function: Address Geocoder | By FSA | Segment Data Model 
 

Items a through e (i, ii) provide a detailed explanation of how the address geocoder is structured 
(see Steps 1, 2 above): 

a.  If geocoding at intersection is requested, check for intersection data (look for user defined 
delimiter) and if found, geocode by intersection; otherwise, 

 Function:  Use Intersection Delimiter  

b.  Attempt to geocode to address by matching street number, street name, street type, street 
direction and municipality information (if municipality information is not found, lookup municipality 
via postal code if this option is selected); and if this operation fails, 

 Function: Lookup Municipality via Postal Code 

c.  Attempt to geocode using street alias (includes street former name) if this option is selected; 
and is this operation fails, 

 Function: Geocode to Street Alias 

d.  When geocoding to address - relax first on street type, then on street direction, then on street 
prefix if these options are selected.  If at this stage a match has been found: 

 Function: Relax Matching on: 

• Street Type 

• Street Direction 

• Street Prefix 

i)  Attempt to geocode the address to the correct municipality if this option is selected;   
and if this operation fails, 
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        Function: Address Geocoder | By Municipality and FSA | Segment Data Model 

        Function: Address Geocoder | By Municipality | Segment Data Model 

 

 ii) Attempt to geocode the address to the correct FSA boundary if this option is selected;  

                and if this operation fails, 

  Function: Address Geocoder | By FSA | Segment Data Model 

e.   When geocoding using street alias - relax first on street type, then on street direction, then on 
street prefix if these options are selected.  If at this stage a match has been found: 

 Function: Geocode to Street Alias 

 Function: Relax Matching on: 

• Street Type 

• Street Direction 

• Street Prefix 

i)  Attempt to geocode the address to the correct municipality if this option is selected;  

   and if this operation fails, 

 Function: Address Geocoder | By Municipality and FSA| Segment Data  

    Model 

Function: Address Geocoder | By Municipality | Segment Data Model 

 ii) Attempt to geocode the address to the correct FSA boundary if this option is selected;  

                and if this operation fails, 

  Function: Address Geocoder | By FSA | Segment Data Model 

f.    Attempt to geocode to closest address (within user defined tolerance) if this option is  

      selected; and if this operation fails, 

 Function: Closest Address Tolerance 
 
3.   Geocoding to POI point by matching to whole POI name using municipality boundary; 
 
 Function: POI Geocoder | Use Whole Name | To POI Point By Municipality and FSA 
 Function: POI Geocoder | Use Whole Name | To POI Point By Municipality 
 
4.   Geocoding to POI point by matching to whole POI name using FSA boundary; 
 
 Function: POI Geocoder | Use Whole Name | To POI Point By FSA 
 
5.   Geocoding to POI point by matching to whole POI Alias name using municipality boundary; 
 
 Function: POI Geocoder | Use Whole Alias | To POI Point By Municipality and FSA 

Function: POI Geocoder | Use Whole Alias | To POI Point By Municipality 
 
6.   Geocoding to POI point by matching to whole POI Alias name using FSA boundary; 
 
 Function: POI Geocoder | Use Whole Alias | To POI Point By FSA 
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7.   Geocoding to POI point by matching to partial POI name using municipality boundary; 
 
 Function: POI Geocoder | Use Partial Name | To POI Point By Municipality and FSA 

Function: POI Geocoder | Use Partial Name | To POI Point By Municipality 
 
8.   Geocoding to POI point by matching to partial POI name using FSA boundary; 
 
 Function: POI Geocoder | Use Partial Name | To POI Point By FSA 
 
9.   Geocoding to POI point by matching to partial POI Alias name using municipality boundary; 
 
 Function: POI Geocoder | Use Partial Alias | To POI Point By Municipality and FSA 

Function: POI Geocoder | Use Partial Alias | To POI Point By Municipality 
 
10.  Geocoding to POI point by matching to partial POI Alias name using FSA boundary; 
 
 Function: POI Geocoder | Use Partial Alias | To POI Point By FSA 
 
11.  Geocoding to POI point by matching to POI code using municipality boundary; 
 
 Function: POI Geocoder | Use POI Type | To POI Point By Municipality and FSA 
 Function: POI Geocoder | Use POI Type | To POI Point By Municipality 
 
12.  Geocoding to POI point by matching to POI code using FSA boundary; 
 
 Function: POI Geocoder | Use POI Type | To POI Point By FSA 
 
13.  Geocoding to Postal code point using Postal code; 
 
 Function: Postal Code Geocoder | Use Postal Code | To Postal Code Point 
 
14.  Geocoding to street segment centroid using input address by municipal boundary; 
 

Function: Segment Geocoder | Use Address | To Segment Centroid | By Municipality and  
                 FSA 

 Function: Segment Geocoder | Use Address | To Segment Centroid | By Municipality 
 
15.  Geocoding to street segment centroid using input address by FSA boundary; 
 
 Function: Segment Geocoder | Use Address | To Segment Centroid | By FSA 
 
16.  Geocoding to street segments using input address by municipal boundary; 
 
 Function: Segment Geocoder | Use Address | To Street Segments | By Municipality and 

    FSA 
 Function: Segment Geocoder | Use Address | To Street Segments | By Municipality 
 
17.  Geocoding to street segments using input address by FSA boundary; 
 
 Function: Segment Geocoder | Use Address | To Street Segments | By FSA 
 
18.  Geocoding to FSA centroid using FSA as input; 
 
 Function: Boundary | Use FSA | To FSA Centroid 
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19.  Geocoding to PPN point using municipality as input; 
 
 Function: Boundary | Use Municipality | To PPN Points 
 
20.  Geocoding to municipal centroid using municipality as input; 
 
 Function: Boundary | Use Municipality | To Municipal Centroid 
 
21.  Refine address to postal code if this option is selected. 
 
 Function: Refine Address By Postal Code 
 
 
Note: POI Code refers to POI Type listed in the CanMap product.  
          Example: Lester B Pearson International Airport has the POI Code CYYZ (See Appendix 4)    
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Appendix 7: Sample ODBC Connection 
The following ODBC drivers work with GeoPinpoint Suite for geocoding Oracle files: 

• Oracle ODBC Driver for Oracle 8i/9i; 

• Windows ODBC Driver for Oracle; 

 

 

 

 

Hint! It is recommended to use the ODBC driver that is installed with the version of Oracle the user is 
going to be using. Information about the Microsoft Oracle ODBC Driver can be viewed on the Microsoft 
support website (http://support.microsoft.com/default.aspx?scid=kb;EN-US;Q244661) under the title 
“INFO: Limitations of Microsoft Oracle ODBC Driver and OLEDB Provider. 

 

This manual will not provide instructions on how to install the Oracle 8i/9i database or client and   creating 
a service name connecting to the appropriate database. 

 

 
Oracle Table - Permissions 
An Oracle user using GeoPinpoint Suite to geocode their tables should have the following permissions:  

• SELECT (read records into GeoPinpoint Suite); 

• ALTER (add four output columns);  

• UPDATE (add values to these output columns) 

 

 
Oracle Table – Output Columns 
 
Geocoding - Output Columns 

Output Column Data Type 
x number 
y number 

rcode number(10) 
prescode number(10) 

 
 
Install the Oracle 8i/9i client (e.g.: Oracle 8.1.7) – there will be three different option buttons to select 
(Administrator, Developer, User) – for our purposes to connect to an already existing Oracle database, 
we have selected the User option button that will automatically install the correct ODBC driver. 
 
Create a service name to the Oracle database (see Oracle documentation.)
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To connect to an Oracle 8i/9i database in GeoPinpoint Suite follow these steps: 
 

1) Open GeoPinpoint 
 

2) Press the Define Geocoding Path button – define the Geocoding Path 
 

3) Press the ODBC button on the Data Source tab of the GeoPinpoint Suite interface. 
 

4)   The following interface will appear, select the Machine Data Source tab 
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            5) Press the New button 
 

 
 
 
 
 6) The following dialog will appear.  Select the System Data Source option button 
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     7)   Press the Next button. The following dialog will appear 
 

 
 
 
 
 
 
 

8) Select the Oracle ODBC Driver from the list of drivers and press the Next button 
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9) Press the Finish button.  The following dialog will appear 
 
For Oracle 8i: 

 
 
For Oracle 9i: 
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10) Enter values for the following fields in this dialog (Data Source Name, Service Name/TNS Service 
Name, UserID) 

 
 
Data Source Name: This value can be any value (For our purposes, rename the connection to 
                                  something that is indicative of what it is going to be used for) 
 
Service Name: This is the same service name that was created to the Oracle database 
 
 
 
 
 

Note: If an incorrect service name is entered and then a connection is attempted the  
          following message box will be displayed. 

  

 
 
UserID: The username that the user will be connecting to the Oracle database as 
 
 
Oracle 8i: 
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Oracle 9i: 
 

 
 
 
 
 
 

Note: With the Oracle 9i ODBC connection, the user has the option of pressing the Test  
          Connection button, which will yield the following dialog: 

 
 

If the test is successful, the user will see the following dialog: 
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If the test is unsuccessful, the user will see this dialog instead: 
 

 
 
 
 
Press the OK button when all the recommended information has been placed in the ODBC Driver 
Configuration dialog. 

 
 
 
 

Hint! Our newly created Data Source name now appears in the list of available selections 
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If all of the information was entered correctly into the Data Source Wizard, the user should see the 
following dialog appear: 
 

 
 
 
 
Enter the password and press OK and GeoPinpoint Suite will connect to the Oracle database and 
then display the tables that can be accessed through the service name to the Oracle database that 
was selected above. 
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After creating ODBC connection 

 
Let’s say that the user has closed down GeoPinpoint Suite and wishes to access their Oracle database 
using the ODBC button again. 
 
After pressing the Define Geocoding path button and selecting the appropriate geocoding path through 
the Defining Geocoding Path dialog. 
 

Press the ODBC button and the following dialog will appear: 

 
 

Double-click on the Data Source Name which was created earlier under the Machine Data Source tab 
and then the following dialog will appear: 
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Note: If this dialog does not appear or an error message is received, ensure that the Oracle 
         database is still up and running. 

 
Enter the password and press OK  

GeoPinpoint Suite will connect to the Oracle database and then display the tables that can be 
accessed through the service name to the Oracle database that was selected above. 
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Appendix 8: Georef Network Connection 
 
If the user wishes to connect to the Georef on another computer on their network, perform the following 
steps: 
 

• Map a network drive through Windows Explorer 
• Tools > Map Network Drive 

 

 
 

• Select the Drive letter (e.g.: G:) that will represent the Georef network location 
• Press Browse button and navigate to the computer where the Georef is located 

 
Note: Remember to select the Georef folder and not the folders that fall underneath it (i.e.: Ab, 
Com, etc) 
 
The path should either look like one of the following: 
 

 F:\\<network computer\Georef  (i.e.: Selecting the folder above the Georef location     
OR 

 F:\\<network computer  (i.e.: Selecting the mapped network Georef folder) 
 

• Select the Finish button when finished 
 
 
Connect to the Georef on the network 
 

• Open GeoPinpoint Suite (Start > Programs > GeoPinpoint Suite) 
• Select the Data Sources tab 
• Press the Browse button beside the Geo-reference Database textbox 
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The following dialog should appear: 
 

 
 

• Select the mapped network drive that leads to the Georef and then press the Select button 
 
• GeoPinpoint Suite is now connected to the Georef located on the network. 
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Appendix 9: Geocoding dBase (*.dbf) files 
 
Note: For optimal geocoding performance, add an index to the dBase database. Consult the Help  
          Files of the application used to create the dbf file to find steps on how to add an index. If the 
          file is being created from Microsoft Access, an index will be added automatically. 

 
Note: For dBase geocoding, add the necessary 4 output columns in the application used to  
         create the dBase file before using. See below for the data types. 
 
         If the user attempts to geocode a table without these output columns (x, y, rcode, prescode), 
         they will see the following message even if they have similar column names (e.g.: longitude, 
         latitude, rcode, prescode): “GeoPinpoint requires columns x, y, rcode, prescode or similar  
         columns, but failed to add them into the database.  Please add these columns or ensure their  
         existence. Please refer to the user manual for data types of columns." 
 

 

 
GeoPinpoint Suite supports the following versions of dBase: 
 

• dBase III 
• dBase IV 
• dBase V 

 
For dBase data types: 
 

Example of geocoded record 
 

x y rcode prescode 
-135.04936523 60.7188742529 111010101 15 

 
 
Output Columns 
 

Output Column 
Name 

Column Data type 

x Number (width 15) 
decimal places (10) 

y Number (width 15) 
decimal places (10) 

Rcode Number (width 10) 
decimal places (0) 

prescode Number (width 5) 
decimal places (0) 
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Connect to dBase table (database) 
 

• Open up GPP Suite GUI 
• Press Define Geocoding Path and select the geocoding options 
• Press ODBC button 

 
For dBase files, double-click Machine Data Source > dBase Files 
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Press OK 
 

 
 
Choose directory where the dBase files are located 
 
Press Ok 
 
 
 
 
The following dialog will appear allowing the user to select the dBase table to geocode 
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   Appendix 10: Geocoding FoxPro files  
 
 
Note: For optimal geocoding performance, add an index to the FoxPro databases. Consult the  
          Help Files of the application used to create the FoxPro file to find steps on how to add an  
          index. If the file is being created from Microsoft Access, an index will be added  
          automatically. 

 
Attention FoxPro and dbf Users!:  
  
If the file type is FoxPro or dbf and then user does not specify a x or y column but the table contains 
either longitude, latitude or a equivalent value, they will still encounter the following message box 
because GeoPinpoint Suite is expecting a x and y column.  
 

 
 
GeoPinpoint Suite supports the following versions of FoxPro: 
 

• FoxPro 2.0 
• FoxPro 2.5 
• FoxPro 2.6 
• FoxPro 3.0 

 
 
Output Columns 
 

Output Column 
Name 

Column Data type 

x Double, float or numeric (width 
> 15) 

y Double, float or numeric (width 
> 15) 

Rcode Integer or numeric 
prescode Integer or numeric 
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Connect to FoxPro table (database) 
 

• Open up GPP Suite GUI 
• Press Define Geocoding Path and select the geocoding options 
• Press ODBC button 

 
 
 
For FoxPro Files, double-click Machine Data Source > Visual FoxPro Tables 
 

 
 
Press OK 
 

 
 
Choose directory where the FoxPro files are located 
 
Press Ok 
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The following dialog will appear allowing the user to select the FoxPro table to geocode: 
 

 
 
 
 
Exporting and Indexing – FoxPro 
 
If the user is going to be exporting a *.mdb file from Microsoft Access to a FoxPro dbf file, note the 
following: 
 

 Only versions 2.0, 2.5, and 2.6 of FoxPro automatically create indexes (due to Microsoft Access 
adding a index during conversion) 

 If exporting to version 3.0 of FoxPro, the user will need to manually create an index in this file. 
 
Steps to create index for FoxPro 3.0 files: 
 

• Open FoxPro 
• Open dbf file 
• View > Table Designer 
• Select the Indexes tab 
• Press Insert button 
• Enter index name and select column to be indexed 
• Press OK button 
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     Appendix 11: Import geocoded data into MapInfo Professional 
 
 
 
Note: These instructions assume that the user has already geocoded their address 
         database using GeoPinpointTM Suite. 
 
Note: Please make a copy of the sample database if importing the data into another GIS  
         System besides MapInfo (ArcView, ArcGIS).  
 

Sample Instructions 
 
Open MapInfo Professional (e.g.: Start > Programs > MapInfo > MapInfo 
Professional) 
 
File > Open Table 
 
Select the combo box Files of Type – Microsoft Access Database (*.mdb) 
 

 
 
Select the sample database (e.g.: Sample_db) 
 
 
Note: Two sample files have been provided to the user (Check the tutorial folder).  
 

1) Sample_2000.mdb  MapInfo Professional 6.0 
2) Sample_ 97.mdb  MapInfo Professional 5.5 

 
            Attention! Opening the Sample_2000.mdb file in MapInfo Professional 5.5 will  
            not work as it does not recognize the Access 2000 database format. 
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Press the Open button 
 

 
 
 
Select the table that contains the coordinates for each address (e.g.: addresses) 
 

 
 
 
Press the OK button 
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The following is an example of what the user will see 
 

 
 
Table > Create Points 

 
This is the dialog the user will see 
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 Change the dialog to look like this 
 

 
 
 

Press the Projection… button and select the following projection  
 

 
 

Press the OK button 
 
 

Window > New Map Window 
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MapInfo may do two of the following things after pressing the OK button 
 
1) Display the following map  
 

 
 
 
2) Or MapInfo may require the user to specify the Map Table before generating a map 

 
Note: This dialog would only appear if the user had another table open besides  
         the one that the user is attempting to bring into MapInfo  

 
 

 
 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 158 

Change to 
 

 

 
 

 

 
 
 

Now that the data has been brought into the MapInfo GIS system, the user can bring in additional 
layers and  

 
1) Create a map for display purposes to highlight the location data (e.g.: geocoded points) 
2) Perform analysis on the geocoded data using the tools found within the GIS system  
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Appendix 12: Import geocoded data into ArcView v3.x 
 
 
Note: These instructions assume that the user has already geocoded their address 
           database using GeoPinpointTM Suite. 
 
Note: Please make a copy of the sample database if importing the data into another GIS 
         System besides ArcView (MapInfo, ArcGIS). 
 
Note: Two sample files have been provided to the user (Check the tutorial folder). 
 

Sample_2000.mdb – Access 2000 
Sample_97.mdb – Access 97 

 
There are two different methods to bring a table into ArcView v3.x: 
 

1) Convert the geocoded database to dbf format and then add the table; or 
2) Use SQL Connect and connect to the Microsoft Access database and then add the table 

 
 
1.  Convert geocoded table to dbf format 
 
 
Steps for converting database to dbf format for Access 97 and Access 2000 are outlined below. 
 

Steps for Access 97 
 
Open newly geocoded database in Access 97 
 
Select the ‘addresses’ table in the Sample database (e.g.: Sample_97) 
 

 
 
Choose File > Save As/Export 
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Select the option button To an External File or Database 
 
Press the OK button 
 
The Save Table dialog will open: 
 

 
 
Change the value listed in the combo box Save as type from Microsoft Access to dBase IV as 
shown below 
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Press the Export button 
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Access 2000 
 
Choose File > Open 
 
Select the geocoded database (e.g.: sample_2000) 
 
 
Press the Open button 
 
Select the table ‘addresses’ within the Sample database 
 
 
Choose File > Export 
 
The Export Table dialog will open 
 
 
Select the Save as type combo box and select the value ‘dBase IV’ 
 

 
 
Press the Save button 
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Steps for importing *.dbf file into ArcView v3.2 
 
After the geocoded database has been converted to the dbf file format, the following steps will 
demonstrate how to bring this data in ArcView 
 
 
Open ArcView v3.2 (Start > Programs > ESRI > ArcView GIS 3.2 > ArcView GIS 3.2) 
 

 
 
Select the option button as a blank project and press the OK button 
 
Select the Tables icon and then press the Add button 
 

 
 
Navigate to the location of the dbf file  
 
Note: Please see instructions above on how to convert an Access database to dbf format  
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Select the address.dbf file 
 

 
 
Press the OK button 
 

 
 
 
Now that the table has been brought into ArcView, proceed to the section entitled 
“Steps to create an event theme in ArcView” to see the steps to display the geocoded data 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 165 

2.  Use SQL Connect in ArcView 
 
After the database has been geocoded using GeoPinpoint Suite, the following steps will 
demonstrate how to bring this data in ArcView 
 
Open ArcView v3.2 (Start > Programs > ESRI > ArcView GIS 3.2 > ArcView GIS 3.2) 
 

 
 
Select the option button as a blank project and press the OK button 
 
Choose Project > SQL Connect 
 
Select ‘Microsoft Access Database’ from the Connection combo box 
 
Press the Connect… button 
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Navigate to and select the sample database (e.g.: sample_<2000/97>.mdb) 
 

 
 
Press the OK button 
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Select under Columns <All Columns>  
 
In the Select textbox - type * (as shown below) 
 
In the from: textbox - type addresses 
 
In the Output Table textbox - choose a name for the output table (e.g.: addresses) 
 
The dialog should look similar to the example shown below 
 
 

 
 
Press the Query button 
 
Press the Disconnect button 
 
Close the dialog by pressing the X on the top right hand side of the dialog 
 
 
 
 
 
 
 
 
 
 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 168 

The following is an example of the table displayed in ArcView after using SQL Connect 
 

 
 
 
Now that the table has been brought into ArcView, proceed to the section entitled 
“Steps to create an event theme in ArcView” to see the steps to display the geocoded data 
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Steps to create an event theme in ArcView 
 
Double-click on the Views icon on the left side of the ArcView project window. This will bring up a 
view window called View1. 
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Choose View > Add Event Theme 
 

 
 
The Add Event Theme dialog box will appear.  
 

 
 
Press the OK button 
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Select the sample database 
 

 
 
Press the OK button 
 
 
 
The following is an example of the event theme displayed in ArcView 
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Now that the data has been brought in the ArcView GIS system, the user can bring in additional 
layers and  

 
1) Create a map for display purposes to highlight the location data (e.g.: geocoded points) 
2) Perform analysis on the geocoded data using the tools found within the GIS system 
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Appendix 13: Import geocoded data into ArcGIS 
 
Note: These instructions assume that the user has already geocoded their address 
           database using GeoPinpointTM Suite. 
 
Note: Please make a copy of the sample database if importing the data into another GIS 
         System besides ArcGIS (MapInfo, ArcView). 
 
Two methods will be looked at for loading data in ArcGIS: 
 

1)  
a) View the data in ArcMap 
b) Save the data as a layer file 

2)  
a) Save the data as a shapefile in ArcCatalog 
b) Import the shapefile into a new feature class 

 
 
1.  Steps to preview the data in ArcMap 
 
Open ArcMap 
 
Select the option button A new empty map 
 

 
  
Press the OK button 
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Press the Add data button in ArcMap 
 

 
 
Double-click the Sample_97.mdb or Sample_2000.mdb file (Check the tutorial folder). 
 

 
 
Double-click the addresses table 
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Looking at the Table of Contents (i.e.: dialog with Display and Source tab present at the bottom) – 
ensure that the Source tab is selected. 

 

 
 
Right-click on the addresses table and select the option Display XY data 
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The following dialog appears 
 

 
 
Ensure that the X Field and Y Field have the appropriate value selected (i.e.: X = x, Y = y) 
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Select the Spatial Reference by pressing the Edit… button 
 

 
 
 
Press the Select… button to select a predefined coordinate system 
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Double-click on the Geographic Coordinate Systems 
 

 
 
Select the following projection:  
 
Geographic Coordinate Systems > North America > North American Datum 1983.prj  
 
 
 
 
 

 
 

 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 179 

 
 
 

Press the Apply button 
 
Press the OK button 
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Select the Show Details option button 
 

 
 

 
 
 
Press the OK button 
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Geocoded points from addresses table are then displayed in ArcMap. 
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Save the data as a Layer File 
 
Now create a layer from these displayed points by the following these steps 
 
 
Right-click on addresses Events 
 
Select the option Save As Layer File 
 
 
The following dialog will appear:  

 
 

 
 
Press the Save button 
 
Click Display tab on the Table of Contents (TOC) to see layer (see lower left-hand side of ArcMap 
GUI)  
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2. Steps to create feature class from geocoded table in 
         ArcCatalog 
 
Open ArcCatalog 
 
Navigate through left panel to find the geocoded table (addresses) in the mdb file (sample_97 or 
Sample_ 2000). Sample_ 2000 will be used in this example.) 
 

 
 
 
Right-click on the addresses table 
 
Select the option: Create Feature Class > From XY Table 
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Ensure that the X Field and Y Field have the appropriate value selected (i.e.: X = x, Y = y) 
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Select the Spatial Reference of Input Coordinates… button 
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Press the Select… button 
 

 
 
Double-click on the Geographic Coordinate Systems 
 
 
 
Select the following projection:  
 
Geographic Coordinate Systems > North America > North American Datum 1983.prj  
 
 

 
 

 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 187 

 
 

Press the Apply button 
 
Press the OK button 
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Save the data as a shapefile in ArcCatalog 
 
Ensure dialog looks similar to example 
 

 
 
Press the OK button 
 
Now refresh the ArcCatalog dialog by pressing the F5 button or View > Refresh 
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Note: XYaddresses appears as a shapefile (as denoted by the Type column under the  
         Contents tab) 
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Import the shapefile into a new feature class 
 
 
Right-click on personal geodatabase (e.g.: Sample_db) and select 
Import > Shapefile to Geodatabase 
 
Select the open folder beside the Input Shapefile textbox 
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Navigate to the location where you are currently storing the shapefile that was created earlier 
 

 
 
Press the Open button 
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Press the Change Settings… button 
 

 
 

www.dmtispatial.com       Proprietary and Confidential to DMTI Spatial 
      Not to be disclosed 



© 2006 DMTI Spatial Inc.          Page 193 

Press the Change… button 
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Press the Select… button 
 

 
 

Double-click on the Geographic Coordinate Systems 
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Select the following projection:  
 
Geographic Coordinate Systems > North America > North American Datum 1983.prj 
 

 
 

Press the Apply button 

 

Press the OK button 
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Press the OK button 
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Press the OK button 
 
 
 
Press F5 or View > Refresh to refresh the display so that the newly created feature class can be 
displayed 
 
Select the XYaddresses Personal Geodatabase Feature Class and click the Preview Tab 
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Open ArcMap 
 
Press the Add data button 
 

 
 
Navigate to and select the XYaddresses Personal Geodatabase Feature Class  
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Select the newly created feature class 
 

 
 

Press the Add button 
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Now that the data has been brought into the ArcGIS GIS system, the user can bring in additional 
layers and  

 
1) Create a map for display purposes to highlight the location data (e.g.: geocoded points) 
2) Perform analysis on the geocoded data using the tools found within the GIS system 
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Appendix 14: ISO 19115:2003 Compliant Metadata  
 
Metadata Notification 
 
On May 15th, 2005, DMTI Spatial data products will incorporate metadata that are IS0 19115:2003 
compliant.  
 
This product now includes structured metadata files as provided in XML and HTM format. These 
metadata files reside with the graphic or database files to which they are associated. It is recommended 
that users review and customize the metadata as per their specific needs. 
 
This latest addition to CanMap® and its related products is another enhancement that we believe will 
benefit our users and increase your overall product satisfaction.  
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